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for Stonepaw



Preface to the fifth edition The 5th edition of the ComicRack Manual is before you. This ends a gap of almost 9 months from the preceding edition. We experienced as many as 9 builds of ComicRack during this period. Build 0.9.137 was the biggest release since the 4th edition of the manual, and we have been building on since then. The past 9 months have been another positive journey for the ComicRack software. Notable were a number of changes in the GUI (like sidebar gauges, icons, tile layouts), enhancements in the details view (gap information, checkboxes), a reworked smart list editor, a reworked colors tab, a few cosmetic changes (‘book’ in place of ‘eComic’, ‘panel’ in place of ‘window’), and a large number of new, excellent scripts. While all the chapters in this edition of the manual feature a lot of new material, it is the ‘Scripts’ chapter that has major alterations. Among each category of scripts, we have detailed 2 types: Editors’ Choice (must-have, excellent scripts) and Popular scripts. All other relevant scripts are briefly mentioned. This change is to ensure that the new user does not get overwhelmed with a huge number of ever-increasing scripts, and also to keep a control on the number of pages in the manual. Thus starts a trend at consolidation. I have realised that there is no end to explaining things. Increasing the number of pages with every build just for the heck of ‘detailed’ explanation is not worthwhile. So, you will notice that a few pages which were there in the previous editions are now no longer there. However, there is no loss of any relevant information. Also notable is an attempt on further making the manual pleasing to the eyes and inviting to the reader. The ‘Tips’ section is completely re-done throughout the manual now. You will also notice some of your favorite comic characters popping out here & there, talking to you! Finally, almost all of the new screenshots now feature the copyright-free web comics. A large number of old screenshots have also been replaced in a similar fashion. Hopefully, by the next edition, the entire manual will feature web comics only. I hope to release atleast 1 edition per year (or, if time permits, 2 editions). A few days back, I have also released the QuickManual, which is targeted at priming the first-time user, and should not be viewed as a replacement of this exhaustive manual. I shall not forgot to thank cYo for his ultimate vision of the best comic reading and managing software ever created. My friends Stonepaw, cbanack, perezmu for supporting me and encouraging me to learn python. The guys at Microsoft, for making Windows 7, the best OS till date. The geniuses at Adobe, for making InDesign, Acrobat, Photoshop and Illustrator, my tools for creating this humble manual. So guys, that’s all! Hope you read this, and like it. Till next time, adios!



600Wpmpo 14 July 2011



Preface to the second edition It feels very nice to write the preface for the second edition. The first edition of the manual was a simple, brief and rather amateur work. Things have changed since then. This time, I have used (with no formal training) Adobe Indesign CS5 for the page layout and design of the manual, and feel quite confident recommending this excellent software to friends having similar interests. The manual has been almost completely rewritten and restructured. The section on ‘reading lists’ has been expanded and now is a detailed manuscript on the topic. We now have a separate (and muchdeserved) chapter on ‘scripts’, discussing almost all of the important scripts. Sections which were inappropriately long have been abridged (the comic display settings section earlier spanned 4 pages, now it packs more information in a single page). The manual now has a proper (hyperlinked) table of contents and an index. Each chapter also has its own table of contents. However, cross-referencing has still not been implemented (due to a bug in InDesign) and is in the to-do list for the next edition. While most of the wiki-copied sections have been replaced, some of them are written so perfectly that I have decided against changing them. With this edition, a new pattern of diagrams have been introduced, consisting of screenshots outlined with different strokes and explanatory text alongside. I have always been impressed with the ‘teach yourself visually’ series of books, and have adapted their style to provide the manual an almost professional look. Overall, the manual has improved in both the quality of content and the number of pages. Not surprisingly, with this release, the file size of the manual has also doubled. For this reason, the manual is being released in two formats: original/HQ version (recommended), and a small-sized (low-quality) version. No preface would be complete without thanking cYo. A lot of us move on with time, but some great individuals keep true to their dreams and pursue them to perfection; cYo is one of those people. I would also take this opportunity to thank my friends Stonepaw (for proof-reading the first edition) and quidam (for helping me out with portions that I didn’t understand properly). I hope the manual would prove useful to the users of ComicRack™. I intend to keep on improving the manual, and releasing new editions from time to time, both to add the features that I missed, and to add the new features as they are introduced. Just like with the previous version, please support the manual project by giving it a good read, and pointing out any errors that you discover.



Preface to the first edition



There comes a day in everyone’s life when one says to himself, “What had I been doing all this time?” Such a day revelled on me about 2 years back when I stumbled upon a software called ComicRack™. At that time, I had just, rather painstakingly, completed organizing about half of my comic collection in a record 2 weeks’ time, and was quite smug with the feat. So, anyway, I installed it and began experimenting with my unorganized comics. In those days, ComicRack™ was neither so much popular, nor the monster (in terms of functionality and efficiency) it is now. Still, it took even less than an hour to sort out all the gigs of my eComics, all decked up with metadata and stuff. Navigating eComics became a breeze, and managing my comics took less time than reading them. That was the experience I hadn’t forgotten till date. While my tastes in reading comics have changed a lot since then, ComicRack™ has been my constant companion. Over the years, I have seen ComicRack™ undergo a huge number of positive changes. A lot of features have been added, some of them so subtle that unless you look for them, you won’t find them! I introduced a lot of my friends to ComicRack™. Every few days, someone or the other would say “Yeah, this software is good, but I wish it had this feature also”, or something on these lines. While it felt nice to look at their blushing faces when I told them that what they wanted was already there, I also agreed with them that such a program should have a proper help file. Many reviewers, who had kind words of praise for ComicRack™, also criticised it for lacking a manual. A few months back, I finally got around to making one. I immediately realised that the plethora of features (“ComicRack™ is not just features rich, it is Bill Gates features rich”) made it quite overwhelming to compile and explain everything. Still, I have tried my best at doing what should have been done a lot earlier: making a foundation for a proper manual for a software that deserves it more than anything else. Since I am no web designer or software geek, the manual’s look is still amateurish despite of my hard work. Some sections are shamelessly copied from the ComicRack™ wiki. In spite of using ComicRack™ for many years, I am still not completely familiar with some of the features, and they might be fully and properly explained in future editions. Please download the manual and give it a read. Do point out any errors (of both omission and commission) and I’ll try my best to rectify them in the next update. Please give suggestions as to how we can further improve the look of the manual. If you dislike anything in the manual (or the whole of it), please feel free to give constructive criticism.
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About the Manual Who needs this book The ComicRack™ Manual is for 3 kinds of users. First, the ‘naive’ user who has never used the ComicRack™ software. Second, the ‘casual’ user who knows the basics of the program, but feels overwhelmed by the sheer number of features that ComicRack™ provides, and would like to master them at his own pace. Lastly, the ‘advanced’ user, who wishes to expand his knowledge of the different features that ComicRack™ has to offer.



Book Organization



ics into custom lists and smart lists to suit a particular reading style or mood. Chapter 9, ‘Scripts’, introduces you to a large number of add-ons for ComicRack™ to increase its functionality by automating various tasks. Chapter 10, ‘Web Comics’, introduces you to the Web Comic format; creating, downloading and updating Web Comics using ComicRack™ is also explained. Chapter 11, ‘Network Sharing’, tells you how to use ComicRack™ for sharing your eComic collection with your family & friends over the internet.



The ComicRack™ Manual has 12 chapters:



Chapter 12, ‘Support’, provides information on how you Chapter 1, ‘Introduction’, gives you the basics of eComics can help the ComicRack™ project. It also tells about various ComicRack™ resources on the web. and ComicRack™. Chapter 2, ‘Getting Started’, explains installing ComicRack™ and using it for the first time.



Chapter Organization



Each chapter groups together a number of sections that Chapter 3, ‘User Interface’, introduces you to the winhave a common theme. A chapter may also contain pages dows, menus, and toolbars of ComicRack™. that give you the background information needed to understand the sections in a chapter. Every section has an Chapter 4, ‘Browser’, discusses the browser window in introduction to the task at hand, a set of full color screendetail. You get to know about the library, folders and pagshots, and steps that walk you through the task, and a set es tabs, the sidebar, and the search browser. of tips. This format allows you to quickly look at the topic Chapter 5, ‘Reader’, discusses the reader window in de- of interest and understand it instantly. tail, including basic navigation, toolbars, and tab bars.



Chapter 6, ‘Configuring’, shows you how to setup ComicRack™ according to your taste, using the Preferences dialog, comic display settings, list layouts, and workspaces. Chapter 7, ‘Managing’, helps you organize your eComic collection using metadata. The Info dialog and reading lists are described in detail. Chapter 8, ‘Lists’, explains in detail how to organize eCom-



How to Use this Manual The Conventions in this book



Using the mouse



A number of typographic and layout styles have been The book uses the following convention to describe the used throughout The ComicRack Manual to distinguish actions you perform when using the mouse: different types of information.



Click



Blue italic



Press your left mouse-button once. You generally click Blue italic type represents the names of commands and your mouse on something to select something on your options that you interact with. Most of the blue italic screen. The word ‘single-click’ is synonymous with the terms are indexed. word ‘click’.



Blue stroke



Double-click



Blue Underlined



Right click



Blue stroke text indicates keyboard shortcuts. These Press your left mouse-button twice. Double-clicking are alternatives to performing the desired actions with something on the computer screen generally opens the mouse. whatever item you have double-clicked.



Blue underlined text indicates hyperlinks. These are ei- Press your right-mouse button. When you right-click anther cross-references to text somewhere else in the book, ything on the computer screen, the program displays a or links to resources on the internet. shortcut menu containing commands specific to the selected item.



Numbered Lists



You must perform the instructions given in Red numbered lists in order to successfully complete a section and achieve the final results. Blue numbered lists denote the various components of the menu / window being discussed.



Bulleted Lists



Drag and drop



Move your mouse pointer and hover it over an item on the screen. Press and hold down the left mouse button. Now, move the mouse to where you want to place the item and then release the button. You use this method to move an item from one area of the computer screen to another.



These bulleted lists point out various optional features. You don’t have to perform them as steps.



TIPS



Tips and Queries



Tips and Queries offer additional information, including hints, tricks, and solutions to some common problems faced by users. You can use this information to go beyond what you have already learned. You can easily identify the Tips & Queries in any section by looking below the scissors cut-off.
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Introduction Are you new to ComicRack™? This chapter introduces you to the world of ComicRack™ and eComics. Welcome aboard!



What is ComicRack™ ? • System Requirements • Supported Languages



Feature Overview



3 3



3



4



eComics: Basic Facts6



• Will my metadata stay preserved if I transfer my eComics to another computer?6



What is ComicRack™ ? ComicRack™ is the best eComic reader and manager for Windows computers. It is an all-in-one solution to read and manage your comic book library. It is actively maintained, has a strong user base and is FREE. ComicRack™ uses Comic Book Archive files, which have the extension .CBR or .CBZ and are simply renamed RAR or ZIP files, respectively. Apart from the standard CBR & CBZ formats, ComicRack™ supports various other file formats also including PDF, CB7(7z), TAR(CBT), DJVU and may add further formats in the future.



System Requirements • Supported Operating Systems: Windows 7, Windows Vista, Windows XP SP3 • Processor: 400 MHz Pentium processor or equivalent (Minimum); 1GHz Pentium processor or equivalent (Recommended) • RAM: 128 MB (Minimum); 2 GB (Recommended) • Hard Disk: Up to 40 MB of available space may be required • CD or DVD Drive: Not required • Display: 800 x 600, 256 colors (Minimum); 1024 x 768 high color, 32-bit (Recommended) • Software: .NET  framework 4.0 is required to run ComicRack™ 0.9.122 and higher, Ghostscript 8.7 (optional) is needed for complete PDF support.



Supported Languages ComicRack™ is multilingual. The latest release of ComicRack™ always contains all language packs in the setup. ComicRack™ is available in the following languages: • English • Dutch • Slovak • German • Polish • Chinese • Czezh • Japanese • Hungarian • Italian • Greek • Turkish • Spanish • Portugese • Russian • French • Finnish • Croatian



3



I wonder if my language is in there...



Feature Overview Read your comic books the way you want: Fast navigation, auto scrolling, auto rotation, dynamic zooming, automatic page fitting, magnifier, manga mode, full screen reading, dual screen support, multi-tab interface.



The powerful integrated library allows you to bring your whole collection to life. With different ways to group, sort and present all the data of your comic books, it helps you rediscover your hidden treasures.



ComicRack™ allows you to edit and show the information of your comic books. You can even change the color and sharpness of comic pages.



4



Edit eComic pages, rotate them to your needs, change the reading order or add additional information.



ComicRack™ can batch convert your comic books to all important formats (including PDF). And all this in done in the background while you keep on reading.



ComicRack™ can be adapted to your needs. Optimize page display, share your library in your local network or change the user interface language.



5



eComics: Basic Facts eComics are basically archives of individual page images and usually have the extension .CBR or .CBZ. eComics are thus defined as RAR/ZIP/7z files containing JPG, BMP, PNG, or GIF images, with the extension changed to CBR/CBZ/ CB7 respectively. ComicRack™ organizes eComics by storing metadata as XML snippets (either as part of the big library file ComicDB.xml) or as single small files (called Comicinfo.xml) into eComics. As eComics can have a variety of formats (PDF, CBZ, CBR, CB7, CBT), the ability to save metadata differs: • PDF: No archive at all, no place for ComicInfo.xml or any custom metadata. • CBR: Rar format can not be written (proprietary) • CBZ: ComicInfo.xml is updated • CB7: ComicInfo.xml is updated • CBT: “Streaming” archive, no update because of performance issues. The recommended format is CBZ or CB7, as ZIP/7z are freely available formats while RAR is owned by RarLabs. They have released the unRAR capabilities but not the RAR. Thus, the ComicInfo.xml file is changed/added for CBZ and CB7 eComics only, while for all other archive formats (including CBR), it is not touched.



Will my metadata stay preserved if I transfer my eComics to another computer? All eComic formats recognized by ComicRack™ that are in your library, are stored in the database file (ComicDB.xml), so you can easily backup/restore their metadata. In case of CBZ (also in CB7, but not in normal zip or 7z) files, ComicRack™ also stores metadata as the Comicinfo.xml file within these file formats. Once the Comicinfo.xml file is stored in CBZ or CB7 files, the metadata in these file formats will stay preserved no matter wherever or how many times you transfer them. However, upon transfer, you will lose non-comic metadata information: last page read, current page, tags, rating, read percentage, opened count, added/opened date etc. Technically you can retrieve metadata from CBRs as well, since the metadata is also stored in the secondary stream of an eComic. This means that as long as you don't move the eComic to a non-NTFS partition or burn it to a CD or something, you will be able to retrieve metadata from CBRs also. This also implies that in case of CBR files, the metadata is lost if you transfer the file to another computer. However, its metadata (or any file format, for that matter) can be saved by backing up the database (ComicDB. xml) from the Preferences dialog. Backing up the database saves absolutely everything, including the non-comic metadata that is not preserved in the Comicinfo.xml file. For more information, see the section on Database Backup.



6



Getting Started Are you ready to experience ComicRack™? In this chapter, you learn the basics of installing and getting started with ComicRack™. Come on in!



Installation First Run



• • • • 



Open a file Start a new library Drag and Drop Basic Concepts



9 12 12 13 14
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Reading Pdf files15



Installation Installing ComicRack™ is a very simple process. Just follow the step-by-step instructions below to get ComicRack™ working on your system. The steps outlined below depict the ComicRack™ installation on a PC running Windows 7. If you have a different (supported) operating system, the screens may appear slightly different. 1. Download the latest ComicRack™ setup file from the ComicRack™ download page. Double-click the setup file to open the installation wizard. Click Next to continue. 2. Read the license agreement, and click I agree to continue. 3. Now you can see the description of the components by positioning your mouse over them. If you wish, you can choose the components that you want to install, and uncheck those that you don’t. We recommend a complete installation with all components selected. 1



2



3



4. Choose the folder in which to install ComicRack™. The default location is C:/Program Files/ComicRack. 5. ComicRack™ (build 0.9.122 and higher) requires .NET framework 4. If not already installed on your system, the ComicRack™ installer will offer to download it from the internet. 5a. Pressing No will continue with the ComicRack™ installation, but the program will not run untill the required .NET installation is completed. Instead, the .NET framework initialization error will occur on running ComicRack™. 4



5



5a



The right ingredients are a must!



9



5b. The .NET framework can be installed through the offline standalone .NET installer, either prior to or after the ComicRack™ installation. However, the simplest way is to click yes when the ComicRack™ installer prompts you. Accept the .NET license terms and let it install. 5b



6. Just after the .NET framework installation completes, a dialog box appears, asking for an immediate system restart. 6a. Click Restart Later, and let ComicRack™ complete its installation and then manually restart your system. 6b. If, however, you are installing .NET prior or after ComicRack™ installation, you can safely click the Restart Now button when asked by the .NET installer. 7. Click Finish to complete the installation. 6a



6b



?
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From where do I download Microsoft .NET Framework 4.0 so that I may use it for offline installation? Following are download links for all Microsoft .NET Framework 4.0 versions available: • Download Link (Web Installer) (requires Internet connection at installation time) • Full Standalone Installer (supports x86, x64 and ia64 architectures but some features are not supported on ia64 for example, WPF) • Full Standalone Installer x86 (If you need to install it in x86 system only) • Full Standalone Installer ia64 (if you need to install it in ia64 system only)
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First Run As you are going to start ComicRack™ for the first time, we would like to welcome you to the ComicRack™ community. Wishing you a lifetime of comics, with a little help from the most complete, yet incredibly easy software that you have just successfully installed. So, come on, lets start ComicRack™! 1. Double-click the ComicRack™ icon to open the program. It can be found on the desktop or under All Programs in the Windows Start Menu. We recommend pinning the program shortcut to the taskbar (Windows 7) or the start menu for quick access.



2



3



2. A Windows Security Alert may pop-up, indicating that Windows Firewall has blocked some features of ComicRack™. You may check all options and safely click the Allow access button. This is a once-only step and won’t be required every time you start ComicRack™. 3. You will be greeted with the ComicRack™ splash screen. 4. A dialog will open requesting you to Donate to ComicRack™ if you wish. To know more about Donations, please read the section on Donations. Even if you decide not to donate, ComicRack™ is fully functional. In this case, click Skip for now. 5. The default  ComicRack™  window is open, and your program is up and running !
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4



5



Open a file Opening your first comic book with ComicRack™ is the quickest way to get started! There are a number of ways to open books with ComicRack™: • From the Tools menu at the far end, click Open Book. • From the Main menu at the top of the window, click the File menu and then click Open File. • Alternatively, you may simply use the Ctrl+O keyboard combo. • Double-clicking any supported comic book archive in windows explorer will launch that file with ComicRack™. • Right-clicking any supported comic book archive in Windows Explorer and selecting Open with ComicRack™.



Start a new library Adding your comic book collection to ComicRack™ is the first step in managing/organizing your ever expanding comic collection. Here is a quick startup on how to start a new comic book library with ComicRack™: 1. From the main menu at the top of the window, click File and then click Add Folder to Library. Alternatively, you may simply use the Ctrl+Shift+A keyboard combo. 2. Browse to where your comics are. Select your I better quickly start comic book folder, and click Ok. a new library! 3. ComicRack™ will scan the folder (and its subfolders) and add all books to the Library. The pending background tasks indicator on the status bar at the bottom of ComicRack™ will display a spinning logo while searching. These steps may have to be repeated if you have your books in more than one folder. The next time you add a book to one of the added folders, you may click the Scan book folders button from the file menu, or simply restart ComicRack™, and the newly added files will be displayed in your ComicRack™ library. More advanced features of the library shall be discussed in the forthcoming chapters.



1



2



3
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Drag and Drop You can also drag and drop your books into ComicRack™ to read them or to add them to the ComicRack™ library. New users find this the most convenient way to get started! Here is how you can use this feature:



1



• From an explorer window, select a book. You can even select a batch of books. • Drag & drop it over the Reader window (if you want to read it) or the Browser window (if you want to add it to the library). Learn more about these windows & the user interface of ComicRack™ in the next chapter. With the left mouse button clicked, drag a book from explorer towards the ComicRack™ window.



2a



Drag and drop your book over the Reader window (this is the window that you see occupying the upper half of the default ComicRack™ interface).



3a



Drag and drop your book over the Browser window (this is the window that you see occupying the lower half of the default ComicRack™ interface).



13



2b



Yes Pluto! Drag & drop. I know you can do it!



Release the mouse button to drop the book over the Reader window. You can now read your book with ComicRack™.



3b



Release the mouse button to drop the book over the Browser window. Your book is now added to the ComicRack™ library. Now, whenever you open ComicRack™, you can access the added book from the browser window.



Basic Concepts Now that you are familiar with opening your comic books with ComicRack™ and adding them to the ComicRack™ library, here is a basic concept overview:



Here you see a number of quick access lists, akin to playlists in a music player. You will later learn to make your own lists.



More than 1 book can be opened at a time by means of tabs.



When no book is open, here you see cover thumbnails for recently added and recently read books. These can be double-clicked to open the book for quick access.



Here are the books that you added to your ComicRack™ library.



When do we get paid for telling all this?



Here is the book currently being read. Scroll down with the mouse to proceed reading to the next page. Single-click to close the Browser window. Double-click on the open book to take it to the fullscreen mode.



Double-click any book from your ComicRack™ library to open it for reading.
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Reading Pdf files Out of the box, ComicRack™ has very limited support for PDF files. Basically it tries to get all the images in it and displays them. Of course, this works for most book PDFs but not for eBooks which also contain a lot of text. However, you can convert ComicRack™ to a full blown, fully compliant PDF reader and have the advantage of all the built in library functions (cover, page thumbnails and previews, database etc.) You simply have to download the official ghostscript release and install it on your system. Make sure to install the correct version. If you run ComicRack™ as 32 bit, you must install the 32 bit version of ghostscript (the 32-bit or 64-bit info can be found in the lower right-hand corner of the ComicRack™ splash screen). After this, ComicRack™ will automatically use it and display PDFs as good as Adobe Reader.



Ghostscript is a suite of software based on an interpreter for Adobe Systems’ PostScript and Portable Document Format (PDF) page description languages.



Just follow these 2 simple steps to install ghostscript on your system: 1



2



Double-click the downloaded Ghostscript setup file. The WinZip self-extractor will open up. Click on Setup to begin the extraction.
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Once the extraction is complete, the ghostscript setup dialog will open. Here, if you wish, you can change the installation directory. To begin the installation, click Install. The Ghostscript setup log will open and a scrolling list of files being copied to the system will be seen. Once installation is complete, the setup dialog boxes will close. Please note that you do not need to open or run the ghostscript program just installed. Simply running ComicRack™ on a system having ghostscript will open & read pdf files perfectly.



Before Ghostscript



After Ghostscript



Opening the ComicRack™ manual pdf file in ComicRack™ on a system that does not have ghostscript. See how ComicRack™ displays only the images on a page.



Opening the ComicRack™ manual pdf file in ComicRack™ on the same system after installing ghostscript. Now, ComicRack™ displays the manual just like Adobe Reader.



User Interface Getting familiar with the interface and terminologies of ComicRack™ will serve as a primer for later understanding the myriad functionality ComicRack™ has to offer. Don’t skip this one!



Main Window18 • Docking Grips 19 • Toolbars & Tab bars20 • ComicRack™ Status Bar21



Menus22 State Indicators • • • • • • • 



Ribbons 24 Stars 24 Ratings 24 Pending Background Tasks25 Dog-ears26 Cover Browser26 Icons26
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Main Window This chapter is essential for understanding the terminologies used to describe the various parts of ComicRack™. Take some time to familiarize yourself with the components. ComicRack™ broadly consists of 2 main components, the Reader window and the Browser window. You manage your comic books in the Browser, and you read them in the Reader. The ComicRack™ Reader and Browser are supplemented by their respective toolbars and tab bars. The Browser is supported by the Sidebar, which carries the library, plus all the reading lists. At the top of the ComicRack™ window is the Main Menu (which autohides when a comic book is opened), and at the bottom lies the Status Bar. Shown below is the default interface for ComicRack™:



Main Menu



Reader Toolbar



Reader Tab Bar



1



Reader Window



2



Browser Window



Browser Tab Bar



Sidebar Toolbar



Sidebar You’ll be seeing a lot more of this window from now on!
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Browser Toolbar



Status Bar



Docking Grips In its default layout, ComicRack™ contains as many as 3 ‘hidden’ or ‘optional’ panels. These can be identified by noticing the dotted extenders known as Docking Grips. Clicking on these docking grips toggles off/on the 3 optional panels, viz. Search Browser, Favorites & Small Preview. Apart from these, there are 3 more docking grips that assist in changing the layout of the ComicRack™ window contents. Although, technically speaking, the Sidebar also is an optional panel, yet it is active in the default ComicRack™ setup. This is due to the essential functionality of the Sidebar (discussed in forthcoming chapters). Please also note that the Info Panel docking grip is not seen in the default setup. It shall be discussed later. The locations and names of all the docking grips are tabulated below:



4 2



1



5



3



6



Location



Name



1



Between the Browser Toolbar above and the Browser window below



Search Browser Docking Grip



2



Between the Sidebar Toolbar above and the Sidebar below



Favorites Docking Grip



3



Between the Sidebar above and the Status bar below



Small Preview Docking Grip



4



Between the Reader Window above and the Browser Tab Bar below



Browser Docking Grip



5



Between the Sidebar on the left and the Reader window on the right



Sidebar Docking Grip



6



Between the Browser window above and the Status bar below



Info Panel Docking Grip



4



Favorites Panel



Search Browser



2



1 5



3



6



Small Preview



Info Panel 4
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With the Sidebar toggled off, the Browser Tab Bar sits just above the Browser Toolbar. Please remember that the Sidebar comes back when the Folders tab is clicked. Therefore, if required, it has to be toggled off independently for both the Library tab and the Folders tab. It should be noted that the Pages Browser does not have the Sidebar, and thus does not display the Sidebar docking grip.



5



Toolbars & Tab bars The Comic Reader is the area where the open comic books are displayed. Just above the Reader window is the Reader Tab Bar on the left, and the Reader Toolbar on the right. The Reader Tab Bar shows the tabs for currently opened comic books. Scrolling anywhere over the reader tab bar switches its tabs. It continues into the Reader Toolbar, which contains several buttons and menus required for customizing how comic books are displayed in the Reader.



The Browser Tab Bar contains tabs for the Library Browser, Folders Browser, and Pages Browser, which are all integrated with the Sidebar Toolbar and the Browser Toolbar. The Sidebar folders & lists can be opened in a new tab here. Shared libraries also show up here in their own tabs. The Library and Folders tabs open up their respective content in the Sidebar, while the Pages Tab uses the entire Browser window to display details regarding the pages of an open comic book. Please note that scrolling anywhere over the tab bar switches its tabs.



Browser Tab Bar



Reader Tab Bar



Reader Toolbar



hmmm... That’s a lot of toolbars!



Sidebar Toolbar



The Sidebar toolbar contains the icons required for working with the sidebar. The content of the Sidebar Toolbar changes with respect to the tab open in the Browser Tab Bar.
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Browser Toolbar



The Browser toolbar contains a number of options for viewing a variety of comic layout styles in the Browser. The content of the Browser Toolbar changes with respect to the tab open in the Browser Tab Bar.



ComicRack™ Status Bar The ComicRack™ Status Bar is present at the very bottom of the ComicRack™ window. It displays important information about your comic books. • At the very left of the Status Bar, the total number (and size) of comic books displayed in the Browser is seen. This number indicates the number of comic books present in the list selected in the sidebar. The file path of the currently selected book is also seen. The Library list is the default, and reflects your entire comic book collection archived with ComicRack™. • Next to it is the number (and size) of the comic books currently selected in the Browser window. For some users, this might be the quickest way to find out the size of a particular comic book, or a group of many comic books.



Number of selected comic books / Size/File Path



Pending Background Tasks Indicator Current Page of the open comic book



Total comic books displayed in the Browser/ Total Size



Display resize slider



Caption of the opened comic book Page count of the opened comic book Server Statistics



• At the right end of the Status Bar, the Display resize slider is present. This is used when you wish to increase or decrease the size of the comic books view (thumbnails, tiles or details) in the Browser window. The resize slider can be dragged to the right to increase the thumbnail or the tile size, and, in case of the details view, the row size. • Left to the resize slider is the page count of the opened comic book, followed by the current page number of the open comic book and the caption of the opened comic book, in that order. • Still left is the Pending Background Tasks Indicator, • If you are sharing your library over the network, you will see a round icon at the extreme right of the Status Bar; that shows an animated icon whenever info data this is the Server  Statistics button, clicking which will from files is being read, or web comics are being upopen the Server Statistics tab of the Tasks Dialog showdated. Clicking it brings on the Tasks Dialog showing displaying all the detailed server statistics for your ing the Background Tasks tab. It is described in detail shared library. later in this chapter.



The Pending Background Tasks Dialog displays all pending tasks, with options to abort them immediately.



The Server Statistics dialog displays all the details regarding network traffic of your remote library.
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Menus The ComicRack™ Main menu contains a number of self-explanatory menus. Each menu has a number of sections, containing several functions. All of these functions have been described in relevant chapters. Here is a brief overview of these menus. The File menu comprises 6 sections, the main functions of which are as follows: 1 1. Opening or closing comic books 2. Creating a new tab 3. Organising and updating the library folders and files 4. “File-less” comic book entries 3 5. Opening remote libraries 6. History 7. Exit or Restart



2



4



5 6 7 The Edit menu comprises 6 sections, the main functions of which are as follows: 1 1. Opening the comic book Info dialog 2. Undo / Redo buttons 3. Editing comic book pages, plus rating and bookmarking them 4. Copying/exporting pages 5. Refreshing ComicRack™ 3 6. Opening the Preferences dialog



2



4 5



?



How do I hide / unhide the main menu ?



The ComicRack™ main menu can be hidden using the Shift+F10 keyboard combo, and can be subsequently toggled on/off using the Alt key. Please note that for this feature to work even when no comic book is open, you should turn off the show main menu if no comic book is open option from the Preferences dialog.
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The Browse menu comprises 3 sections, the main functions of which are as follows: 1. Quick links to toggle ComicRack™ components on/off 2. Shift back and forth the comic lists 3. Browsing / Editing workspaces and list layouts 1



2 3 The Read menu comprises 4 sections, which have the following main functions: 1. Shifting between comic book pages 1 2. Shifting between individual comic books 3. Shifting between Tabs 4. Options for Autoscrolling



2



3 4



Bruce was correct. These are a lot of menus!



The Display menu has 3 sections, which contain: 1. Comic Display Settings dialog 2. Page customization options (Layout, zoom, rotation) 3. User interface customization options The Page Layout options can also be accessed from the Reader Toolbar.



1 2



3



The Help menu contains important links to the ComicRack™ forum and homepage. The ComicRack™ documentation links to the ComicRack™ wiki page. A Support button is there for users wishing to donate and maintain ComicRack™.
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State Indicators ComicRack™ makes use of a number of small icons, called State Indicators to provide a lot of at-a-glance information.



Ribbons The green ribbon indicates the last page read in a comic book. The yellow ribbon is the current page open in the comic book. If the current page being read is earlier than the last page ever opened, the yellow ribbon scrolls down as the comic book pages are read, till the green ribbon is reached. From there on, the green ribbon takes over till the end of the comic book.



Stars You may occasionally see colored stars on comic book thumbnails or in the state column if you use the list view. Each star has a specific meaning. Red: The Web comic has been updated with new pages. The number is the number of new pages. Once the new pages are read, the red stars disappear. Blue: The comic book in the current list that was last opened in the reader. Green: The comic book is currently open in the reader. If no comic book is open, the green star will not be seen. Orange: Data is pending to be written to the Comicinfo. xml file in the comic book archive. This includes changes to the metadata, information on the page images, changes in comic book attributes (like file size and file modified time). Updating your comic book files makes the orange stars disappear. Violet: A fileless comic book. These are simply ComicRack™ database entries for comic books which are not actually present on the hard disc.



Ratings You can rate your comic books in ComicRack on a scale of 0 to 5, with 0.1 increments. Based on your preference, the ratings on the comic book thumbnails can be displayed either in a numerical manner (at the bottom right of the thumbnail), or as rating stars (below the thumbnail). Community ratings (average ratings from reviewers and readers around the world) are also displayed similarly. The community ratings are blue-colored, while ratings assigned by you (called My ratings) are yellow-colored. Please read the section on ratings in the Managing chapter to learn how to assign ratings.
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As the orange stars are basically update reminders, you can reduce a lot of manual updating by allowing automatic updating, allowing automatically writing data to the files, and increasing your page cache. You will learn to access these options from the Preferences section in the “Configuring” chapter.



Pending Background Tasks If there are any currently under-process assignments (called Pending Tasks), then corresponding animated icons are displayed in the Status Bar. These are the Pending Background Tasks Indicators. Double-clicking any of these opens the Pending Background Tasks dialog. Currently, there are 4 types of pending background tasks indicators, any or all of which can be seen running in the status bar, depending on the state of the pending tasks.



Export When the export comic books function is used to convert comic books from one format to another, this indicator will be seen in the status bar.



Scan This indicates that ComicRack™ is currently running a scan on your library folders, searching for new comic books. Write This indicates that ComicRack™ is writing information to the comic book files



Thumbnails This is an indicator depicting that ComicRack™ is currently getting info and creating thumbnails for the comic books being viewed in the browser. It also appears when you update Web Comics over the internet.



The Pending Background Tasks Indicators also integrate with the Windows 7 taskbar, providing you at-a-glance information about the current status of ComicRack™ just by looking at the taskbar.
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Dog-ears On hovering the mouse over a comic book thumbnail in the browser, a small dog-ear of the first page appears, revealing the next unread page underneath. On clicking the thumbnail, the dog-ear attains its complete size and stays on the thumbnail till the mouse clicks somewhere else in the browser. This feature can be turned off from the Preferences dialog.



1



2



3



Cover Browser The cover browser is represented by the the little -/+ signs over the comic book thumbnails & tiles in the browser. This indicates the number of pages in the comic book marked as front cover. It can be used as a visual indicator to identify comic books with variant covers, browse through the covers, and choose the cover to be displayed as the thumbnail/ tile. Cover number currently selected for display as thumbnail



Total number of front covers in the comic book



-1/2+ Click on the + sign to browse forward the front covers. Click on the - sign to move back. Please note that once you reach the last front cover, clicking on the + sign will move you on to the first cover. Browsing through 4 covers in a comic book.



Icons ComicRack™ supports display of a variety of icons for Publisher, Imprint, Format and Age Rating categories. You can view icons at various places in ComicRack™: • Tiles view • Icons column in details view • Info Dialog These icons are installed in the Resources folder inside your ComicRack™ install directory.
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Browser Having problems managing your comic book collection? Suffering heartaches while spending hours organizing them? Look no further, the ComicRack™ browser will come to your rescue!



Introduction to the Browser • Docking the Browser



Library • • • • • • • 



Browser Toolbar Browser Views Thumbnail View Tiles View Details View Stacks Layout Browser Context Menu
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29 31



Folders



40



Pages
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• Deleting Pages • Saving Pages



Sidebar



• Sidebar Toolbar



Search Browser



• Using the Quick Search box • Using the Negation filter



Optional Panels • Favorites • Small Preview • Info Panel
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Introduction to the Browser The Browser is the section of ComicRack™ that helps you manage / organize / browse your comic book collection. All (or selected) comic books are displayed in the Browser window in the form of thumbnails, tiles, or details view. The Browser window is ably supported by the Browser Toolbar and the Browser Tab bar. The Sidebar is an essential component of the Browser, and changes its content according to the tab open in the Browser Tab Bar. There are 3 tabs in the Browser Tab Bar, viz. Library, Folders and Pages. Out of these, the Library and the Folders tabs are integrated with the sidebar, while the Pages tab does not contain the Sidebar. The Browser window is often referred to as the Library Browser, Folders Browser or Pages Browser, depending on which tab is open in the Library Tab Bar. The Search Browser, Favorites panel, and the Small Preview are the 3 optional panels of the Browser, and can be toggled off/on using their respective Docking Grips.



Browser Tab Bar



Sidebar Toolbar



Browser Toolbar



Browser Window



Sidebar



Favorites Panel



Search Browser



Browser Window Small Preview 29



Docking the Browser The position of the Browser in the ComicRack™ window can be changed to suit the user’s choice. The Dock menu present on the extreme right of the Browser Tab Bar can be used to place (dock) the Browser to the left, right or bottom position in the ComicRack™ window. The Browser docked at the bottom is the default setting.



Dock Bottom (default)



Dock Left



One important setting is the Dock Fill option, which unifies the Browser tab bar with the Reader tab bar and the Reader Toolbar. In this setting, comic books open on this Unified Tab bar.



Dock Right



The Dock menu also contains the Info Panel right option. You can use this option to dock the Info Panel (docked at bottom of the browser by default) to the right side of the browser. The Info Panel is an optional panel that can be used by various scripts to display customized info there. The Info panel opens in the browser, but without any complementary scripts enabled, it doesn’t show up. To know more about the Info panel, see the corresponding section at the end of this chapter (page 28).
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Library The Library tab is the section of ComicRack™ that allows the user to interact with archived comic books via the Browser window (referred to as the Library Browser when the Library tab is open). Adding comic books to the ComicRack™ library gives you the advantage of storing metadata, which then can be used for organizing your comic book collection. Using the Library tab, you can view in the Browser window either your entire collection (via the Library folder in the sidebar), or selected groups of comics (via reading lists in the sidebar).



Library Browser



Library folder Reading Lists



Group by Publisher



Arrange by Series



Stack by Series



Group by Year



Stack by Publisher



Arrange by Number



Grouping, Stacking and arranging comic books help in customizing the view as per your choice. Different permutations and combinations of these 3 options provide a variety of environments for managing comic books. Play with these settings for a while to find the layout that suits you best. Please note that the stacking option is not available in the details view. For changing between multiple list layouts, please read the section on List Layouts.
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Browser Toolbar The Browser Toolbar is the key to understanding and customizing the Library Browser’s layout and appearance. The following (from left to right) are the essential components of the Browser Toolbar, with a brief info on their functions:



Sidebar button



Stack



Views



Previous / Next



Group



List Layout



Undo / Redo Scripts Quick Launch



Arrange Duplicate Current List



Quick Search



Sidebar button



Click to toggle the Sidebar off/on



Previous / Next



Move through the succession of lists recently browsed



Views



View as thumbnails, tiles, or details. Option to filter comic books based on read state, and duplicates.



Group



Based on desired metadata, comic books can be grouped to appear under a common heading in the browser.



Stack



Based on desired metadata, comic books can be stacked so that they appear placed one above the other in the browser.



Arrange



Comic books can be arranged to appear in a desired sequence.



List Layout



Arrange the comic book viewing options with List Layouts.



Duplicate Current List



Builds a new smart list out of your current settings.



Undo / Redo



Undo or Redo the last operation performed in ComicRack™.



Scripts Quick Launch



A quick launch bar containing buttons for all the installed scripts.



Quick Search



Search your library based on keywords, series, writer, artists, descriptive, or filename.
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Browser Views The Views button helps choose how and what comic books are displayed. Basically, you get to choose from 3 different views: thumbnails, tiles & details. We shall discuss these in the coming sections. The Views button also provides options for showing all / not read / reading / read comic books as well as finding duplicate comic books (see below) in your collection. You can also choose to show only comic books or show only fileless entries. To know more about fileless entries, read the section on Fileless comic entries in the Managing chapter.



Choose from among thumbnails/tiles/details for viewing your books in the browser



Use this option to collapse/expand all grouped books in the browser window.



Quick toggle between read/unread/reading books.



ComicRack™ has its in-built duplicate file finder. Click here to show duplicates in your library. Details are discussed below. Advanced users can use the “Duplicates Manager” script (discussed later).



If you wish to show only fileless book entries, or only ‘real’ books, this is option is the quickest way to this.



Click the Views button to toggle between the thumbnails, tiles & details views. Clicking the small downward-pointing arrow beside the views button opens up the views menu.



Removing Duplicates The Views button provides an option to find & remove duplicate issues that you may have accumulated over time. There are a number of metadata values needed for comics to be matched; most importantly, Series Name, Issue Number and Volume. Note that “Superman #1” and “Superman V1 #1” would not match, nor would “Superman V1 #1” and “Superman V2 #1”. To use this feature, select Views in the Browser window and select Show Duplicates. After a slight delay (dependent on the total number of issues in the library, folder or list that this feature is run against), all applicable duplicates will display, allowing the user to make any changes or deletions desired.
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There will be No duplicates in my library! Never!!



Thumbnail View The thumbnails  view is the most commonly used view, and is enabled by default. Double-clicking on a (unstacked) thumbnail opens up its comic book in the reader. It is possible to increase or decrease the size of the comic book view by using the comic book display resize slider present on the status bar. Dragging the slider to the right increases the size of the thumbnails or the tiles , and, in case of the details view, the row size. Drag it to the left for the reverse.



Name of the metadata field used to group the comic books



State Indicators: Ribbons



State Indicators: Ratings



State Indicators: Stars



Last page opened



Text you choose to display below the thumbnails



Dog-ear on selected thumbnail If you do not require this feature, Uncheck Selected thumbnails have a dog-ear from Preferences dialog



See List Layouts for more info



?



To select multiple comic book thumbnails: • To select a consecutive group of thumbnails without using the keyboard, drag the mouse pointer to create a selection around the outside of all the items you want to include. • To select consecutive thumbnails, click the first item, hold down the Shift key, and then click the last item. • To select nonconsecutive files, hold down Ctrl, and then click each item you want to select • To select all of the thumbnails visible in the browser, click Select All from the Browser context menu, or click Ctrl+A



Can I group or arrange books in reverse order?



Yes. Just note the direction of the arrows on the group / arrange buttons. A downward-pointing (default) arrow indicates alphabetical order (from A to Z). You just need to simply click on the button and the arrow will reverse its direction, giving you the reverse alphabetical arrangement (from Z to A). Please note that this feature does not apply to the Stacks option.
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Tiles View The tiles view is relatively more informative than the thumbnails view. Double-clicking on a (unstacked) tile opens up its comic book in the reader.



Name of the metadata field State Indicators: Ribbons used to group the comic books



State Indicators: Icons



State Indicators: Stars Stacked tiles: While stacking thumbnails just places them one atop the other with no added information, stacking tiles provides a number of at-a-glance info:



Rating



Dog-ear on selected tile If you do not require this feature, Uncheck Selected thumbnails have a dog-ear from Preferences dialog



?



Tile Info • • • • • • 



Caption Creator info Summary Size Format File name



Number of books in the tile Number of opened books Total size of the comic books in the tile, and total number of pages



You can select multiple tiles (whether stacked or not) in just the same way as you would select thumbnails.



What are the little -/+ signs that sometimes appear on my comic book thumbnails & tiles in the browser?



This is the cover browser. It indicates the number of pages in the comic book marked as front cover. Its functionality is described in detail in the User Interface chapter.
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• • • 



Details View The details view is the most informative view. Double-clicking on a comic book column in the details view opens up its comic book in the reader. It should be noted that you can not stack comic books in the details view.



The details view arranges your comic books using metadata fields (of your choice) as columns. You can group & arrange the comic books as you did in the thumbnails & tiles view). The grouping metadata field is seen as a heading with a disclosure triangle that can be used to toggle on/off its individual comic books. The comic books of a group are arranged by your specified metadata field, seen as a small arrow on the column heading. A single-click on this arranging column-head toggles the order from descending to ascending (notable from the direction of the arrow: pointing downwards or upwards, respectively) You can change the column positions by a simple drag and drop using the mouse. In the above example, the ‘My Rating’ column is initially present to the right of the ‘Pages’ column. If you wish to place it to the left of the ‘Series’ column, simply click and drag it to the left till it reaches its desired position, and then release the mouse button.



Right-clicking the header of any column in the details view brings about the details context menu. It contains the following options: ▶▶ Auto size column. Resizes (expands or shrinks) the column according to the maximum length of its contents. ▶▶ Auto size all columns. Resizes (expands or shrinks) all columns according to the maximum length of their respective contents. ▶▶ Auto fit all columns. Resizes (expands or shrinks) all columns so that all of them fit completely in the browser window. ▶▶ The Layout menu, which also appears as an independent menu on clicking in any empty space in the browser. This contains the view, arrange, group, and layout copy/paste options. ▶▶ Metadata field columns currently open in the browser. You can uncheck those you don’t want. ▶▶ All available metadata fields that could be used as columns in the details view. Explanatory tooltips appear on hovering the mouse over a column title.
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ComicRack™ supports display of a variety of icons for Publisher, Imprint, Format and Age Rating categories. All the icons for a particular book are visible in its details view.



The now-familiar rating stars in the details view allow a quick assignment of the rating by clicking at them.



Spin buttons are displayed alongside metadata fields that have a numeric value. Example of these fields include fields like Number, Read, etc. You can simply click at the up/down spinners to increase/decrease the respective values. Please note that the spin buttons are seen only on the activated (clicked) rows.
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Date/Time Format



Rating



Icons



Spin Buttons



Comicrack™ supports long/short/relative time formats for date-related metadata fields, specially the File Modified field. Just hover your mouse at the field header to get a dropdown arrow, clicking which reveals the options.



Gap Information



Checkboxes



The Gap Information field in the details view shows visual information about missing issues of a series.



Metadata fields that can have a Yes/No value are displayed as checkboxes in the details view. These include fields like Series Complete, Read, B&W, etc. You can simply click at them to toggle yes/no. You can also select more than 1 books, and use the checkbox fields in a single go.



gap starts here gap both before & after this issue gap ends here



Stacks Layout Stacking implies placing books one above the other in the ComicRack™ browser. To stack books in ComicRack™, just click the Stack button on the Browser toolbar, and choose the metadata field that you wish to use as the criterion for stacking your books. Stacking comic books in the thumbnail & tiles views brings forth few additional features. Double-clicking on a stack opens up its individual comic books in the browser, and additionally the Stacks toolbar appears on top of the browser window. Stacks display the average (community) rating of the stack. Bookmarks on stack display how many of the books in the stack have been read.



Click to close the Stack



Viewing comic books as thumbnails, stacked by series



Stack Title



Navigate comic books using the Stack toolbar



Double-clicking the stack has opened up the comic books. The stacks toolbar is visible at the top. As we had stacked the comic books by series, the stack title (in the middle) displays the series name.



?



Search Browser



Clicking the docking grip present at the top of the browser opens the search browser. Combining the Search browser with the Stacks toolbar gives greater level of control over navigating the comic books



Can I choose which comic book will be shown as the cover for a particular stack ?



Yes. Open up the stack by double-clicking it. Now, right-click any comic book to get the browser context menu (see next page), with an additional option: Set as top of stack. You can use this option to select any comic book (from all the comic books constituting the stack) to appear as the stack cover.



You can even choose any custom picture file to be displayed at the top of a particular stack. Right-click any stack to get the browser context menu, with an additional option: Set custom stack thumbnail. This option will allow you to browse to the desired picture file (.JPG/.PNG/. GIF/.BMP/.ICO) of your choice to be used as the stack cover.
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Browser Context Menu Right-clicking in any empty space in the browser brings about the Layout menu that carries over most of the features of the browser toolbar. This includes the view, arrange, group and stack menus. Right-clicking any comic book in the browser brings about the browser context menu. Many of the submenus share an overlap with the main menu. While most options are self-explanatory, a brief overview of some of the features is presented below. Features like exporting comic books, copying and pasting data, and lists-related options are discussed in the relevant sections.



Opening the Info dialog



Rating comic books on a scale of 1 to 5



Run scripts on selected comic books



Opening comic books in the Reader Mark comic books as Read or Unread Find comic books with similar metadata Open comic book with Windows Explorer Use any comic book cover as background image for a list open in the browser



You can use the Reset List Background option from the List layout button on the Browser toolbar to undo changes made to list background.
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Folders The Folders tab allows you to browse your computer for comic book folders in a Windows Explorer-like fashion. Selecting a folder opens the contained comic books in the browser (referred to as the Folders Browser when the Folders tab is open). Similar to the Library browser, the Folders browser is integrated with the sidebar, and can display a Favorites panel above, and a Small Preview panel below. The Search Browser is also available.



Sidebar Toolbar



Browser Toolbar



Favorites



Search Browser



Viewing selected folders as shortcuts for quick access. Just right-click a folder in the sidebar, and select Add Folders to Favorites



Sidebar



Clicking on any folder displays its comic book content in the Folders Browser. Right-clicking any folder opens the context menu



Folders Browser Essentially the same as the library browser, the only difference is that it displays the content of a particular folder on your system. Can be grouped, stacked, arranged in the same way as Library Browser



Small Preview



?



How do I exclude books in subfolders of a favorite folder from being displayed by default in the browser ? The Include all subfolders icon is useful for toggling off and on the subfolders of a favorite folder. To use it, click on a folder in the favorites panel. Next, click on the Include all subfolders icon. All subfolders shall now display in the library. Clicking on the icon again will toggle the subfolders off.
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Pages The Pages tab is the section of ComicRack™ that allows the display and organizing features for the pages of a comic book in the browser window (referred to as the Pages Browser when the pages tab is open). The Pages tab is visible only when a comic book is open. ComicRack™ provides labelling for individual pages of a comic book, as Front Cover, Story, Advertisement, Letters etc. The page type can be changed to suit your needs. Similar to the library browser, the pages browser also has the options for viewing, arranging and grouping comic book pages. It should be noted that, unlike the library and folders browsers, the Pages Browser does not contain the Sidebar.



Just like the Library Browser and the Folders Browser, options for viewing thumbnails / tiles / details view are there in the Pages Browser too. The only difference is that here individual comic book pages are displayed in the Browser.



Views



Page Filter Menu The Page Filter menu can be used to toggle types of pages on and off. These changes also apply to any other comics as well as the reader view. For example you can uncheck the Advertisement setting and you will never see a page marked as Advertisement as you’re reading a comic.



Page Context Menu



Right-clicking on any page in the Pages Browser invokes the Page Context Menu. This contains options for changing Page Type, Page Rotation, Adding / removing Bookmarks, reordering pages within a comic book, copying page(s) to another location, and marking pages as deleted (so that they do not show anymore in ComicRack™).
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Pages Browser Context Menu Right-clicking on any empty space in the Pages Browser invokes the Pages Browser Context Menu. This contains the view / arrange / group options analogous to the Pages Browser Toolbar. Please note that the Pages Browser Context Menu is different from the Page Context Menu.



Deleting Pages The Pages Browser provides options for marking the pages as deleted, without actually removing the page(s) from the comic file. There are several ways to do this: • Change the page type to ‘Deleted’: 1. Right-click on a page(s) to open the page context menu 2. Go to the Page Type option 3. Click on the Deleted option • Press the Del button on the keyboard • Choose Mark as deleted from the Page context menu. A red cross would be visible on the page, indicating that it has been marked as deleted and will not show while reading, while it is not actually removed from the comic book file.



Saving Pages You can save page(s) as a single image file(s). To do so, right-click any page thumbnail in the pages browser and select the Copy Page option. You can now just paste the page anywhere in either windows explorer, or an image editor of your choice. Multiple pages can be similarly saved by selecting them individually using the Ctrl key, or selecting all pages via the Select All option. An alternate way to save pages is to simply to drag the page(s) to a location on your computer from the pages view.



?



How can I reorder pages within a comic book ?



You can change the order of your comic book pages by simply clicking and dragging them to where you want them to be. A black line shows where it will be reinserted. You can also use the Move to Start or Move to End options in the right-click context menu for moving a page to the beginning or end of a comic book respectively. A Reset original order option is always there if you wish to undo these changes.
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Sidebar The Sidebar contains the Library folder, the default ComicRack™ folder that contains your entire comic book collection archived with ComicRack™. The Sidebar is also needed for creating, organising, and accessing reading lists. The Sidebar is an essential component of the Browser, and changes its content according to the tab open in the Browser Tab Bar. There are 3 tabs in the Browser Tab Bar, viz. Library, Folders and Pages. Out of these, the Library and the Folders tabs are integrated with the sidebar, while the Pages tab does not contain the Sidebar. Just like the browser, the sidebar is referred to as the Library sidebar or the Folders Sidebar, depending on which tab is open in the Browser Tab Bar. There are as many as 3 ways to toggle the sidebar on/off: • Main Menu → Browse → Sidebar • Clicking the docking grip on the left border of the Reader window • Shift+F5 keyboard combo Please note that the default ComicRack™ layout has the sidebar open. An overview of the Sidebar is shown below:



Library folder



Gauges



The default (albeit virtual) folder containing all the comic books added to ComicRack™



These are visual indicators for new/unread/total books in a list. The Red gauge represents new books added in the past 10 days. The yellow gauge indicates the unread book count, while green one shows the total book count.



Smart Lists



The default folder containing a number of Smart Lists for you to start with



Temporary Lists



Arranging files and folders in the Sidebar



Double-clicking any reading list from windows explorer opens it directly in ComicRack™. This is made possible by means of the Temporary Lists folder. It can also be used to store experimental reading lists, as any list kept here is deleted on the next run of ComicRack™.



You can make folders within folders for arranging your lists . Any number of lists can be kept within a folder, and can be dragged up or down, both within a folder and from one folder to another. Lists or folders can be placed at any level of hierarchy



Sidebar Context Menu Right-clicking on any folder or list in the sidebar brings up the Sidebar context menu. It contains a number of options, many of which share an overlap with the Sidebar Toolbar and are covered in the next section.
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Arrange lists within a folder in alphabetical order Lists can be copied and pasted from one folder to another within the sidebar Export Reading list saves a reading list on the desktop or any folder of your computer. You can then transfer it to use it on another system or share it with your friends, who can use the Import Reading list option to add it to their ComicRack™ sidebar



Sidebar Toolbar



Favorites



New Folder



New List



Open in new Expand/Collapse window all



New Smart List



Open in new tab



Favorites



Open in new window



Include all Subfolders



Refresh



Folders Sidebar Toolbar



Library Sidebar Toolbar



Shown below are the essential components of the Sidebar Toolbar, with a brief info on their functions. Just like the sidebar, the sidebar toolbar is referred to as the Library sidebar toolbar or the Folders Sidebar toolbar, depending on which tab is open in the Browser Tab Bar.



Open in new tab



Favorites



This opens the Favorites panel at the top of the Sidebar. Select any item in the sidebar, rightclick, and you will be able to add it to the Favorites panel.



New Folder



Creates a new folder to organize your lists. Lists can be dragged and dropped into the sidebar folders.



New List



Creates a new custom list



New Smart list



Creates a new smart list



Open in new window



Opens the currently selected library, list or folder in a separate window.



Open in new tab



Opens the currently selected library, list or folder in a tab. You can return to the library and leave the tab open, or open multiple tabs.



Expand/Collapse all



This expands/collapses all the lists and the root folders in the sidebar with a single click.
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Search Browser Short of using reading lists, the Search Browser offers one of the quickest ways to access a comic book or a set of comic books based on the metadata present. The Search Browser is present above the main Browser window. Please note that the default ComicRack™ layout has the Search Browser hidden. The Search Browser can be toggled on/off by any of the following: • Main Menu → Browse → Search Browser • Clicking the docking grip on the upper border of the Browser window • Using the Shift+F8 keyboard combo As the Search browser opens, a three-part pane will slide down, allowing you to narrow down the visible comic books by using three metadata fields. The drop-down menus can be chosen to display the comic book metadata attribute of your choice. Choosing a particular metadata attribute delimits the comic book search results in the Browser accordingly.



Column 1



Column 2



Column 3



Negation



The Negation filter (exclamation marked) helps in excluding a particular set of results from the Browser.



Column Header To quickly clear the filters in the Search Browser, simply click the column header, and it will revert to showing ‘all’. If you click on the header of the leftmost column, this won’t reset all the columns; instead, it will now reflect the search results based on the new filters provided.



Drop-down Menu The drop-down menu of all the 3 columns contain the same metadata fields. The Search Browser provides more than 20 commonly used metadata fields to filter your search results. As per your requirement, you can choose any combinations of them.
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Using metadata fields to filter the search results



In the example shown, we have chosen the 3 columns as Publishers, Genres and Series. Clicking a Publisher will narrow down the Genre column to all comic books of the particular Genre; clicking a specific genre narrows down the third column to all the comic book series that have the selected genre. Finally, the comic book listing is narrowed down further once you click on a particular comic book.



That is some really fast search! Yipeee..!



Using the Quick Search box You can filter the Search Browser’s results by also using the Quick Search box. The information displayed by Search Browser depends on the current content: the reading list currently selected (if any) and the metadata selected in the columns. But this content also depends on Search box of the Browser Toolbar. The quick search box is an on-the-fly filtering tool: simply start typing, and the Browser window as well as the Search Browser will display (as you type) all the items with matching description fields. If the search box is empty, ComicRack™ displays all the comic books of the current metadata selected in the Search Browser or the reading list; if the quick search box contains text, only the subset of items matching this text. The example here displays the result shown by the Search Browser after typing “wat” in the quick search box.



Using the Negation filter The little exclamation (!) mark present next to the drop-down menu in each column is the Negation button. If you select this, all comic books that do NOT match the criteria are displayed. For example, you are browsing the comic books of a particular publisher. Now, if you wish to see comic books of all genres except one-shots, here is what to do. First, select ‘One-shots’ in the genre column. You will see that the series column promptly displays all the One-shots of your chosen publisher. Now, with ‘one-shots’ already selected, click the (!) button in the genre column. You will now get all series except those tagged as one-shots.



?



Can I select multiple fields in the Search Browser ?



Yes. Just hold the Ctrl key and click on desired metadata fields. To select a number of fields in continuity, you can hold the Shift key and click the first and the last fields; all fields in between the 2 clicked ones will be selected.
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Optional Panels Favorites This small panel at the top of the Sidebar will display the folders or lists of your choice for quick access. Please note that the default ComicRack™ layout has the Favorites panel hidden. There are 2 ways to toggle the favorites panel on/off: • Clicking the favorites icon on the sidebar toolbar (yellow star) • Clicking the docking grip on the upper border of the sidebar Any item present in the sidebar can be added to favorites. Individual comic books cannot be added or displayed in the Favorites panel. Its purpose is for Sidebar items that you use frequently and would like quick access to. This is especially helpful when one has a large assortment of lists and folders. To add a list / folder to favorites: 1. Select any item in the sidebar 2. Right-click to get the sidebar context menu 3. Click the Add to Favorites option



Favorites window in the Folders sidebar. Here we can see individual folders added as favorites. The file path of the folder is also seen. A single click on a folder in the favorites opens its content in the browser



Favorites window in the Library sidebar. You can add both custom lists & smart lists to favorites. Single click on a list in the favorites to open its content in the browser



You can have different sets of favorites items for the Library sidebar & the Folders sidebar at the same time. Right-click on any favorite item to refresh or delete it. Deleting a favorite list / folder would have no effect on the original source, as these are only shortcuts pointing to their respective lists / folders.



Small Preview This small panel at the bottom of the Sidebar will display the comic book selected in the Browser, whether opened or not, without changing its read state and bookmarks. You can use the mouse wheel in the small preview panel to scroll to the next/previous pages.



Goto next / previous page or first / last page



Please note that the default ComicRack™ layout has the Small Preview hidden. There are as many as 3 Open the book ways to toggle the small preview on/off: in the Reader • Main Menu → Browse → Small Preview • Clicking the docking grip on the lower border of the sidebar • Shift+F7 keyboard combo An overview of the Small Preview is shown alongside.
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Refresh



Show one / two pages in the preview



Close the preview window



Info Panel The Info Panel is an optional panel that can be used by script authors to put customized info there, for example open webpage from Web field of comic Info. The Info panel opens in the browser, but without any complementary scripts enabled, it doesn’t show up. A basic knowledge of the preferences dialog & scripts is required to understand this panel, so we recommend that you first get acquainted with these above-mentioned sections, and then come back to the present page. Info Panel scripts are described in detail in the Scripts chapter.



How to use the Info Panel 1. First open the Preferences dialog & go to the Scripts tab. From the Available scripts section, enable the Web link script. Advanced users may also enable the Dummy Comic Info UI/HTML scripts. Click Ok & restart ComicRack™. 2. From the Browse menu, click Info Panel. Alternatively, use the Shift+F9 keyboard combo. 3. Identify the Info Panel docking grip at the bottom of the browser window. Click it to slide open the Info Panel. At its top, you will see tabs depicting the enabled info panel scripts. If only one script is enabled, no tabs will be seen. 4. In the browser, select any comic book with a valid web field. The Web link tab will show the page corresponding to the web address of the comic book. You may browse that complete website through this page. 5. You can dock the Info Panel (docked at bottom of the browser by default) to the right side of the browser with the Info Panel Right option, from the Dock menu. 4



1



2



3



Browser Window Sidebar Info Panel



5
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Reader The ComicRack™ reader is, inarguably, the best book reader in the world. This chapter helps you use the reader to the maximum of its abilities!



Introduction to the Reader51 • Reader: The Basics51 • Reader Navigation52 • Auto Scrolling 53



Reader Toolbar
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Reader Tab Bar55 Quick Open Box56 Overlays57 • • • • 



Navigation Overlay57 Current Page Overlay57 Visible Page Part Overlay58 Messages & Status Overlay58



Page Layout



• Page Layout (Number) 59 • Page Layout (Fit)60 • Rotation61
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Reader Context Menu62



Introduction to the Reader Reader: The Basics The Reader window is the most important part of ComicRack™, as this is where the book pages are ultimately displayed for onscreen reading. Scrolling the mouse wheel moves the open page up or down, and scrolling beyond the end of the page opens the next page of the book. This is the simplest way of navigating the Reader. For further customizations, please see the chapters on Preferences and Keyboard map.



Reader Tab Bar



Reader Toolbar Reader Window



Er... Maybe I better read the next page to learn more about these modes!



There are a number of ‘modes’ in which the books can be displayed in the reader window: 1. Default Mode (Showing the Reader, Browser, and the Sidebar) 2. Reader Mode (with the browser & sidebar closed) (F3) (Clicking on the docking grips between the Reader and the Browser toggle off/on the browser, thus achieving the same result) 3. Fillscreen Mode (with menus and toolbars) 4. Fullscreen Mode (F11) (no menus or toolbars) 5. Windowed Reader Mode (F12) (the Reader gets a window of its own) It is possible to quickly navigate between the first 4 views using the mouse or the keyboard. You can learn more about reader navigation on the next page.
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Reader Navigation The Default Mode



The FillScreen Mode



displaying the browser and the sidebar, apart from the reader



in which the ComicRack™ window (with menus & toolbars) fills the entire desktop



Double-clicking or pressing F11 or the Full Screen button (Reader Toolbar) in the reader window brings up View #2, while clicking the mouse or pressing F3 takes us to view #4.



This is seen after clicking the Full Screen button (Reader Toolbar) (or pressing F11 or double-clicking) in the Reader window of the default view #1 or clicking the mouse (or pressing F3) in View #3.



1



2



4



3



The Reader Mode



With the browser and the sidebar closed, the complete space in the ComicRack™ window goes to the Reader. This is seen after pressing F11 (or double-clicking) in view #3 or pressing F3 (or a single click) in the Reader window of View #1. Pressing F11 (or double-clicking) again brings back view #3, while pressing F3 (or a mouse click) takes us to view #1.



The FullScreen Mode



in which the reader (without any menus or toolbars) occupies the entire desktop This is seen after pressing F3 (or clicking the mouse) in the Reader window of view #2 or F11 (or double-clicking) in View #4. A single click or F3 again brings back view #2, while double-clicking or pressing F11 takes us to view #4.
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Auto Scrolling Auto Scrolling is feature that smartens up the way you move around the page. Instead of scrolling based on constant values (pixels), ComicRack™ calculates automatically and dynamically the best scroll step for you, so that you could scroll in most comfortable way. For example, with some small fixed scroll values you might scroll 5 times before going to the next page. With autoscroll, it usually takes two or three scrolls. It works best in Two Page mode + Fit Width (adaptive). Also in all the cases when page(s) width is bigger than our screen can fit. Autoscroll also affects keyboard hotkeys and mouse wheel behavior accordingly.



Enabling auto scrolling



To enable auto scrolling, from the main menu, goto the read menu & click auto scrolling. You may also use the Ctrl+S keyboard shortcut. While using the Reader, you can toggle auto scrolling on/off with the S key.



Advantages of auto scrolling



Most of the features in the Read menu are self-explanatory and share an overlap with the Reader toolbar, where they are explained. The last 2 options are exclusive, and are the subject of our discussion here.



• Page movement is dynamic & smoother (with smooth auto scrolling also enabled) • If the page is wider than the display area, autoscroll moves to the hidden parts of the page. Without autoscroll, when you reach the bottom of a page wider than the display area, scrolling goes directly to the next page.



Double-page auto scrolling



This is a complementary option that works only if Auto Scroll is enabled. Affects only double page spreads, not the Two Page mode. If you’re viewing a double page spread, enabling this option changes page movement direction. This is noticeable if the page width is bigger than the viewing area and we don’t use Fit Width or similar modes. So you start from the top-left corner of the page displayed and then move to the top-right corner (instead of bottom-left with this option disabled). Most double-page spreads are supposed to be read this way, as our eyes follow from left to the right to the bottom.



Inertial mouse scrolling



This is also a complementary option, but works independent of Auto Scroll. With inertial mouse scrolling & hardware acceleration on, you get an iPhone-like effect where you move the page with the mouse and when you release the button it still keeps on moving (but decelerates).



An book open in the Reader
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With no auto scrolling, a single scroll of the mouse wheel moves the page a few pixels down.



The preferences option Smooth auto scrolling works only with auto scroll enabled. With this we smoothly flow to the next part of the page instead of just instantaneously switching to it. Page movement is more fluent this way. But obviously it’s not as fast because some time is necessary for page movement from one part to another. The Mouse wheel scrolling option is not related to the auto scrolling feature. This is the simple mouse wheel scroll speed based on constant values (pixels)



With auto scrolling enabled, a single scroll of the mouse wheel moves the page more dynamically.



Reader Toolbar The Reader Toolbar can be accessed from the top right of the Reader window (or the Quick Open box). It contains important shortcuts to display, navigate and customize the book pages reading. Shown below are the essential components of the Reader Toolbar, with a brief info on their functions. It should be noted that the Reader Toolbar is visible only when either the Reader window or the Quick Open box is open.



Clicking on this button takes you to the previous page. Clicking the small downwardpointing arrow opens up a drop-down menu that has additional options for going to the previous bookmark or the previous book in the list.



Provides options for showing one or two pages at a time in the Reader window. You can also use the right to left mode for reading manga.



Provides options for displaying book pages by fitting width/ height/all dimensions. You can simultaneously choose the option only fit if oversized to make the original page size the limiting factor.



Provides options for rotating the open book 90o,, 180o, or 270o.



Page Layout (Number) Page Layout (Fit)



Previous Page Rotation Tools Next Page



Clicking on this button takes you to the next page. The drop-down menu has the options for moving to the last Page, next bookmark, or the next book from the list. You can also open up a Random book (or use the Ctrl+Alt+N keyboard shortcut).



Zoom



Zooms in/out the book pages, using the preset (100%, 125%, 150%, 200%, 400%) or custom values. The keyboard combos Ctrl+Oemplus and Ctrl+mouse wheel up zoom in the page while Ctrl+Oemminus and Ctrl+mouse wheel down zoom out.



Full Screen



Clicking on this button toggles off/on the full screen and related reading modes.



Magnifier



At the end of the Reader Toolbar is the Tools menu, which is a completely reorganized and easier-to-use ComicRack™ menu, having multiple important options from all over ComicRack™ in a single pane. Notable is the Show Main Menu option, which when enabled shows the main menu, which can then be toggled via the Alt key.



Viewing the default magnifier to see Jon’s query magnified ! While reading books, ComicRack™ has a Magnifier to temporarily enlarge the desired page portion. The Magnify button in the Reader Toolbar contains options for controlling width, height, opacity and zoom of the magnifier. It also has options for enabling the magnifier’s activation with a long mouse click.



Viewing Garfield’s response with the ‘simple’ magnifier and 50% opacity
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Reader Tab Bar The Reader Tab Bar is present over the top left of the Reader window. It continues into the Reader Toolbar. The Reader Tab Bar shows the currently opened books in a tabbed interface. When no book is open, it displays the Plus (+) tab. Clicking (either left-click or right-click) this tab adds new reader tabs. Double-clicking a book from the browser opens it in the current tab. Clicking on a selected tab toggles between the Browser and the Reader. Right-clicking a tab brings up the tab context menu, which contains options for revealing the open book in the browser or in windows explorer. You can use the Close all but this option from the tab context menu to close all other books in one go.



Every tab contains its own close button that appears when the tab is selected.



When a number of books are open in the Reader, the Tab Bar displays right and left buttons at its ends to navigate between them, and a drop-down menu at the end that contains a list of all the open books.



A single (left) click on the tab of the comic book currently being read, toggles between the Reader & the Browser.



Tabs can be dragged and dropped to change their position to any desired one on the Reader tab bar.



Double-clicking a book from the browser opens it in the current tab (whether empty or occupied by another book) in the reader tab bar. If you hold the Ctrl key while double-clicking, the book will open in a new tab.
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On hovering the mouse over the tab, an info box pops-up that contains the book caption, a brief plot of the book, format (ZIP/RAR), size and number of pages. At the bottom, it also displays the icons and ratings for the book



Quick Open Box The Quick Open box can be seen inside the Reader window when no book is open. While the default ComicRack™ setup displays the No book is open message, once you add books to the ComicRack™ library, the Quick Open box appears in all its glory. It shows all the default reading lists present in Comicrack™. You can set any reading list to be available in the Quick Open box. From every list, upto 10 books can be displayed here, depending on the last time read and added criteria.



Here you can see all the lists that are being displayed in the quick open box. Each list has a ‘disclosure triangle’ which allows you to hide or show the books in the list.



To open an book in the reader, double-click the book from any of the lists displayed in the quick open box.



Select an book and click the open button to read it in the reader window.



Clicking the Browser button toggles the browser off / on. Yes! The quick open box is what suits my style!!



The open file button opens up a Windows Explorer dialog through which you can browse and select any book for opening in the reader window.



Clicking at this drop down menu shows all the file formats supported by ComicRack™
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Overlays The ComicRack™ Reader makes use of a number of overlays to display live information regarding the book currently being read. These overlays can be enabled/disabled via the options in the Reader setup tab of the Preferences dialog. Here we briefly discuss all the overlays.



Navigation Overlay The book pages can be viewed as a filmstrip here. Clicking on any page here opens it in the reader window. The mouse wheel can be used to browse the filmstrip back & forward. The upper left corner displays the caption of the book open in the reader.



The upper right corner displays the time and the battery status (if any).



The Navigation Overlay displays a filmstrip of all the pages of the currently open comic. Just hover your Quick browsing is via the The next/ last page arrows. horizontal scroll bar, which can are seen here. Similarly, on the mouse over the lower border of be dragged left or right to view lower left corner, you have the the Reader window, and the navithe page filmstrip. first / previous page arrows. gation overlay will slide up. By default, the navigation overlay is shown at the bottom of the reader window. You also have the option for showing the navigation overlay at the top from the Reader setup tab of the Preferences dialog.



Current Page Overlay



The Current Page Overlay can be seen in the upper right corner of the reader window. It is visible only when the page in the reader window is changed. It displays the page number (along with the number of total pages). From the Reader setup tab of the Preferences dialog, the page name can also be displayed in this overlay.
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Visible Page Part Overlay You can turn off the visible page part overlay by simply clicking at the cancel button here.



Visible Page part Overlay displays the portion of the page currently visible on the screen with a thumbnail of the entire page currently open in the reader.



Messages & Status Overlay



Messages & Status overlay is seen in the centre of the Reader. The default empty reader window displays the No book is open message. Opening the book (followed by the book caption) and loading pages are other similar messages displayed here.



TIPS I don’t need the overlays. Can I turn them off ? Yes. Open up the Preferences dialog from the Edit menu (or hit Ctrl+F9 keyboard combo): • Goto the Reader setup tab • Scroll down to the Overlays section (or click at the Overlays sub-tab) • You can now uncheck the overlays you don’t want
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Page Layout Page Layout (Number) The Page Layout (Number) options can be accessed from the Display menu (page layout sub-menu), Reader Toolbar, or Reader context menu (page layout sub-menu). You get the options for showing one or two pages at a time in the Reader window. You can also use the right to left mode for reading manga.



In Single Page mode, every image is displayed by itself. So, single pages stay single and double pages stay double.



The Two Pages always displays 2 pages (like a book). If there are forced single pages (like a single page before a double spread or before a page of type Cover), white fill pages are introduced.



The Two Pages (Adaptive) mode is the “classic” ComicRack™ two page mode. Unlike the simple Two Pages mode that introduces white fill pages alongside forced single pages, the Two Pages (Adaptive) mode doesn’t introduce any fill pages. As seen in the picture above, the cover page is displayed as a single page, while rest of the pages as double pages.



The Right to left mode is primarily indicated for reading Japanese manga, which are traditionally read from right to left. This mode is used simultaneously as a limiting factor over all the previously discussed page fitting modes. It is best utilized with the Two Pages (Adaptive) mode, and the right-to-left options from the Behavior tab of the Preferences dialog.
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Page Layout (Fit) The Page Layout (Fit) options can be accessed from the Display menu (page layout sub-menu), Reader Toolbar, or Reader context menu (page layout sub-menu). You get the options for fitting the pages by their width/height/all dimensions in the Reader window.



The Original Size mode displays book pages in their original dimension, without any fitting constraints.



The Fit All mode displays the pages by fitting them with regards to both the vertical and horizontal dimensions.



The Fit Width mode displays the pages by fitting them with regards to their horizontal dimension.



In the Fit Width mode, double pages stay as doubles and are displayed side by side, fitted by width.



The Fit  Width  (adaptive) mode splits a double-page and displays only half of it at once fitting it to width. This is especially useful for people with pivoted monitors or when book pages are scanned in a way where all the images consist of two pages on each one.



The Fit Height mode displays the pages by fitting them with regards to their vertical dimension.



The only fit if oversized mode can only be used simultaneously with the previously discussed page display modes. The only fit if oversized makes the original page size the limiting factor over the selected page display mode. Not selecting this option makes ComicRack™ “force fit” even smaller images by the chosen constraint.
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Rotation The Rotation options can be accessed from the Display menu, Reader Toolbar, or Reader context menu (page layout sub-menu). You get the options for rotating the open book 90o, 180o, or 270o. You can also use the rotate left/right buttons to sequentially toggle between these available rotation modes. Please note that using the rotation option, the pages of the open book are rotated only for display in the reader, while the image files in the book archive are not rotated.



The Reader displaying the page in a 90o rotated state



The Reader displaying the page in a 180o rotated state



The Reader displaying the page in a 270o rotated state



Autorotate Double Pages



You can choose the autorotate double pages option to let the reader window automatically display double-pages in a 270o rotated state. This is a useful feature, specially when you are reading books (having double pages) on hand-held devices that have a relatively larger horizontal dimension.



With the autorotate double pages option selected, whenever ComicRack™ encounters a double-page anywhere in the book, it promptly rotates it over 270o . The page is more comprehensible now in the horizontal position of your hand-held device.
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Reader Context Menu The Reader context menu is seen after right-clicking any page open in the Reader window. Most of the options present here share an overlap with other menus and toolbars in ComicRack™, and are discussed in the relevant sections. A brief overview of the Reader context menu and its sub-menus is presented below.



Opening the Info dialog



Rating books on a scale of 1 to 5



Setting the Page Type



Navigating between books



Changing the Page Rotation



The Books sub-menu also shows a list of the currently open books.



Page Layout Options Page Layout (Fit) options for displaying book pages by fitting width/height/ all dimensions.



Page Layout (Number) options for showing one or two pages at a time in the Reader window. Rotation options for rotating the open book 90o,, 180o, or 270o.



Save Pages The Export Page function allows you to save any page open in the reader window to any folder accessed from the Windows Explorer. This opens a Save Page as dialog where you can choose the page type from JPG/BMP/PNG/GIF/TIFF formats. The Copy page function is also similar, allowing you to paste the copied page to windows explorer. It simply saves the page in its original format.



Minimal User interface



Changes selected page rotation permanently in the book archive. So if you have some pages in file scanned in wrong horizontal/vertical position there is no need to extract images and rotate them in external editor.



Working with Bookmarks



Selecting this option hides the main menu, reader tab bar, reader toolbar and the status bar in the fullscreen view of the reader window.
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Configuring ComicRack™ comes with a number of features that enable you to personalize it to your liking. This chapter will help you learn how to change the way ComicRack™ works to make it easier to use & more efficient.



Preferences



• Reader Setup  Keyboard Map  Touch Gestures • Libraries • Behavior • Scripts • Advanced



66 67 68 69 70 71 72
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Book Display Settings
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List Layouts
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• • • • 



Introduction Saving List Layouts Editing List Layouts Copying / Pasting Layouts



Workspaces



• What is a workspace ? • Saving Workspaces • Editing Workspaces



Command-line Switches
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Preferences The Preferences dialog is essential for configuring ComicRack™ according to your needs. It can be opened either via the Edit menu, or by using the Tools menu. Alternatively, you may use the Ctrl+F9 keyboard combo. The Preferences dialog contains 5 tabs, each of which has a number of sections / sub-tabs. 1. Reader Setup  Display  Keyboard  Overlays  Mouse & Scrolling  Hardware acceleration 2. Libraries  Book Folders  Scanning  Sharing  Server Settings 3. Behavior  Starting ComicRack™  Opening a Book  Reading  Right to Left  Browser  Application  Import & Export 4. Script  Script Packages  Available Scripts  Script Settings 5. Advanced  Languages  Books  Database Backup  Disk Cache  Memory Cache  Hidden Messages  Explorer Integration



In the Preferences dialog, double clicking anywhere on the background toggles between the scroll and the tab layout. The scroll layout shows all the preferences options arranged in different sections in a single scrolling window. The tab layout has these very options arranged in their own subtabs.



If you have any of the following ‘How do I..’ questions, then look no further, the preferences dialog will help you: • • • • • • • • • • • • 



How do I add comic book folders to the ComicRack™ library ? How do I open new files in new tabs? How do I use custom keyboard shortcuts? How do I increase the mouse wheel scroll speed? How do I make sure that deleted files don’t show up again in the library? How do I use ComicRack™ to check its RSS feed? How do I customize ComicRack™ for reading manga? How do I minimize ComicRack™ into the system tray? How do I change the ComicRack™ interface language? How do I remove the overlays? How do I backup my database? How do I open comic books from windows explorer directly with ComicRack™?
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How Do I....



Reader Setup The reader setup tab contains a number of self-explanatory options for customizing the way you wish to read your comic books with ComicRack™. There are 5 sections in the Reader setup tab: 1. General 2. Keyboard 3. Overlays 4. Mouse &Scrolling 5. Hardware acceleration In the Display section, Turning High Quality option off increases page display speed on slower machines. Anamorphic Scaling stretches the comic book page to fit the screen in both dimensions. The Adjustments sliders provide easy changes to the saturation, brightness, contrast, gamma and sharpening attributes of the comic pages. ComicRack™ can be completely controlled by the keyboard. This section provides the default keys for various actions, all of which can be customised according to the user’s choice.



With Smooth Auto Scrolling enabled, moving from one part of the page to the next is more fluent. This works only when auto scrolling is enabled from the Read menu. You can adjust the mouse wheel scrolling speed to your liking. With inertial mouse scrolling & hardware acceleration on, you get an iPhone-like effect where you can kinda move the page with the mouse and when you release the button it still keeps on moving (but decelerates).



The Overlays section contains settings for a number of enhancements for the reader window. Please read the section on Overlays to understand details regarding their nomenclature. All available overlays are shown in the overlay map here. You can uncheck the overlays that you do not wish to show in the reader window. The corresponding overlay in the map greys out. You can also choose to display the page name just below the current page overlay. The size of the overlays also can be increased/decreased by using the overlay resize slider here.



The overlays are quite informative. I like them a lot.



As we have already seen, during installation, ComicRack™ self-optimizes itself for your system. Most of the settings in the hardware acceleration section have already been selected by ComicRack™, and are the ones recommended for your system. If you do not desire the page display change animation, you may disable it.
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Keyboard Map The ComicRack™ keyboard map contains 9 sections: • Library • Browse • Auto Scroll • Scroll • Display Options • Page Display • Zoom & Rotate • Edit • Other Every section contains a number of options with their default shortcut(s). If you wish to change any shortcut, just select its option and it will open in the pane below, where you can easily modify it as per your requirement.



For each keyboard shortcut, there are 3 options: 1 Main and 2 Alternate. Each option has its own drop-down menu, from which you can choose the shortcut key that suits you. You can also use the CTRL, SHIFT, or ALT keys to make a number of combinations and permutations for making the shortcut of your choice. You can use the keystroke button (next to the CTRL/SHIFT/ALT checkboxes) to directly input keys from the keyboard.



The Export button can be used to save the keyboard layout to an XML file on your PC. Such a keyboard layout can reflect your personal likings for the keyboard shortcuts, or can mirror the keys of some other comic reading software that you had to use before ComicRack™. The Import button can be used to browse to such a saved XML keyboard layout on your PC .
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Touch Gestures If you have a computer with a touchscreen, you might find that gestures (motions that you make with one or two fingers) are easier to use than a mouse, pen, or keyboard. ComicRack™ recognizes a number of touch gestures on supported touch-enabled devices. Currently they simply map to square areas in the reader you can click. They are numbered left-to-right, top down, from 1 to 9. By default, if you click (touch with touch display) in the upper corners you change page. In the lower corners, you auto scroll (with page change).



ComicRack™ also recognizes multi-touch gestures: you can zoom in/out, move around page, rotate page, and swipe to next/previous page.



By default, Gesture 1 is assigned to Previous Page action, Gesture 3 for Next page, Gesture 7 for Previous part and Gesture 9 for Next part.



Multi-touch Gestures for ComicRack™ Slide



Pinch in or out



Tap



Touch and hold



Two-finger tap



Drag



Slide your finger lightly on the screen in an up/ down or left/right direction. This gesture is primarily used for scrolling or panning. To scroll up or down quickly, flick your fingertip quickly and repeatedly up or down. Tap the screen to stop the scrolling.



To increases the size of the thumbnails / tiles view, or the row size of details view, start with your thumb and forefinger together in the middle of the screen then pull them apart. To zoom out, reverse this motion.



Touch your fingertip quickly and lightly on the screen. Using this gesture over the browser thumbnails/tiles/details opens up the comic book in the Reader. Tapping in the reader is the equivalent of a mouse-click. Also, tap to open & operate the menus.



The touch and hold menu is equivalent to a right-click. Touch your finger to the screen and leave it there until the context menu is triggered.



Quickly tapping the screen with two fingers (using your forefinger + middle finger works well) in the reader window toggles the navigation overlay.



After you touch a movable item, if you hold your finger on the item and slide, the item slides with your finger. This drag gesture may be used to add browser comic books to reading lists or re-ordering pages in the Pages browser.



Touch Press & Tap



Touch your finger to the screen and leave it there. Tap quickly with a second finger. This touch press & tap gesture is used in the reader window to toggle the magnifier.



Watch all the ComicRack™ touch gestures in action on YouTube !
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Libraries The Libraries tab contains a number of self-explanatory options for customizing your ComicRack™ library. There are 4 sections in the Libraries tab: 1. Book folders 2. Scanning 3. Sharing 4. Server Settings



The Book Folders section helps in adding folders containing comic books to the library. These folders, if checked, would be watched for changes (move / rename) while the program is running. Using the open button, any added folder can be opened with windows explorer.



The Sharing section is used for sharing of libraries over the internet. Select Add Share to open the library sharing config. Here you can also select if you want to share your complete library or only selected lists. You can also select to make your library editable or password protected (recommended). Please read the chapter on Network sharing for further details.



The Scanning section has 2 important options. The first option, if enabled, removes missing files from the library during the scanning process. The second option comes in handy when you decide not to add a file to the library, while that file resides within a comic book folder that is already added to the library.



More on library sharing in the coming chapters!



In the Server settings section, you have the option to input the external IP of your server, and to password protect your private share lists.
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Behavior The Behavior tab contains a number of self-explanatory options for customizing the ComicRack™ experience to your liking. There are 7 sections in the Behavior tab: 1. Starting ComicRack™ 2. Opening an comic book 3. Reading 4. Right to left 5. Browser 6. Application 7. Import & export The Starting ComicRack™ section contains startup tasks for ComicRack™, like scanning for comic book folders and updating web comics. We recommend that you mark all these options to run automatically at startup. You can also check for all the ComicRack™ news and keep informed about new releases. With the Blend animation while fast paging option unchecked, when you keep the page down shortcut pushed, it disables any page transition effect. If it is checked, animation effect is always turned on, no matter how fast you try to switch through pages. Keep the Fullscreen also toggles minimal user interface option selected if you don’t want any menu or toolbar in fullscreen view. You can uncheck the reset zoom option if you wish to read all pages in a particular zoomed mode. A couple of tweaks for the Browser. If you wish to display the browser docking grip while using the reader, you can check the option here. You can also opt for comic book tooltips while hovering your mouse over them in the browser. Also present are options for thumbnail animations. The last option lets you display comic book ratings numerically. Unchecking this option will display the ratings as stars over the thumbnails



While exporting reading lists, you may keep this option unckecked (recommended) to omit file names from being included in the list. Unchecking this option provides better results during list imports.



Here you get the options for opening new comic books in separate tabs. You can opt to close the browser automatically whenever a comic book is opened. You can make ComicRack™ always open a new comic book in a new tab from the option here. You can also choose to open the comic book at the page where it was last closed.



Right-to-left mode is used while reading manga. Left/right movement is also reversed - if book is marked as Manga (right to left), or if your page layout is ‘Right to Left’ then page loads in upper right corner and goes to lower left. True right to left reading - The whole book is mirrored and not only double pages reversed. So you’re really reading the book from back to front.



The comic info dialog can display either simple or 3D covers, which can be toggled by either clicking on them, or using the option here. You also have the option to hide the main menu (also see Tools menu, and use the Alt key). If you wish to have the catalog field for all comic books, you can uncheck the option here that limits the catalog field to fileless comics. Also, you can select to not showing the quick open box.
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Scripts Scripts are essentially plugins or add-ons that extend the functionality of ComicRack™. They can be found in the Index of Scripts section of the ComicRack™ forum. They are usually distributed as a zip file. Working with scripts is explained in detail later in the Scripts chapter.



Let the Scripts do the hard work for you !



Script Packages is the first section in the Scripts tab. It is used for installing/uninstalling the scripts. It displays all the installed scripts, with a brief description of them. Available Scripts is the second section. In its default state, it contains a list of all the scripts that come bundled with ComicRack™. As new scripts are installed, they show up in the available scripts section. It can be used to disable a script without uninstalling it. To disable any of these scripts, just un-check the checkmark next to the script name here, and restart ComicRack™. Reverse the steps for reactivation. The Script  Settings section in the end contains an option for disabling all scripts with a singleclick.



A glimpse of some hugely popular ComicRack™ scripts ! Automatically download metadata into your cbz comic book files



Catch the latest RSS feeds for all the new comics releasing each week Organize & Standardize the comic book file & folders on your PC



Organizer



Remove duplicate comic books with just a single click! Automatically display the next issue to read in all partially read series



Convert selected comic books to fileless entries to save hard disc space
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Advanced The Advanced tab contains sections on the user language interface, database backup, cache settings, explorer integration and other options. Most of these are briefly discussed below. The Languages section at the top helps select the user interface language of your locale. Restart ComicRack™ for the language changes to take effect.



The Books section has the option to allow ComicRack™ to write a small Comicinfo. xml file to comic books. ComicRack™ organizes comic books by storing metadata as XML snippets (either as part of the big library file) or as single small files into comic books. This metadata file is labelled as ComicInfo.xml. The ComicInfo. xml is also instrumental in restoring your comic book database, in the event of a system format or file transfer. Please note that info can be added to only CBZ (zip) or CB7 (7z) files.



If, at this age, I can access the advanced settings, so can you!



The Database Backup allows easy backup & restoration of all the comic book data to a small xml file on your computer, or on a USB drive. It is described in detail in the next chapter.



The cache is the maximum disk space you allow ComicRack™ to use to stock thumbnails, pages and comic books accessed through remote libraries. It allows a smoother reading experience. Since it pre-loads images, you can browse quite fast through a comic book. Default maximum cache size varies depending on the machine. It is set during installation of ComicRack™ (optimization part). The bigger the cache, the bigger the amount of images/thumbnails/comic books that can be pre-loaded. The cache will increase in time as you use ComicRack™. You can also safely delete it. Optimized means that ComicRack™ keeps the compressed image in memory. Advantage is that it can cache more image in memory, disadvantage is it has to uncompress them if needed (images stay uncompressed for about 5 seconds since the last use)



Hidden messages are message boxes you disabled (clicked never show again). To reshow these ‘hidden’ messages, simply click the reset button. Out of a number of supported formats, the checked ones will be associated with ComicRack™, and opening any file having those extensions will automatically launch them with ComicRack™.
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Book Display Settings This option will allow the user to edit the background display of the ComicRack™ Reader Window, as well as choose between display options for the opened comic book itself. There are three ways to open this dialog: using the Display menu at the top, using the Tools menu, or simply hitting F9.



• • • • 



• 



No Page Transition Effect. This will turn the page without any animations. New Page Fades In. This will turn the page with a fading transition. New Page Scrolls In Horizontally. The page will slide onto the reader in a sideways motion. New Page Scrolls In Vertically. The page will slide onto the reader from the bottom to the top. Page Turn Effect. This is an animated motion that simulates turning a page from a real comic by hand.



A vertical divider between double page spreads is seen, with a blank margin around the pages, signifying a real-like imaging of the open comic book. You can use the slider to change the margin size.



The background will blend with the primary color of the page displayed to create a solid color that will change as the page is turned and the primary color changes.



Adjust Color To Current Page Realistic Book Display (with margins) Background Textures



Page Transition Effects



Texture: This will allow the user to load an image file to serve as the background. There are a number of these that come with ComicRack™, and the user may also load their own. You have the option of either None, Tile, Center, Stretch or Zoom, as one would with a Desktop Background. You can also add your own textures to the C:\Program Files\ComicRack\ Resources\Textures\Backgrounds folder. You may also freely download background textures from the web.



Paper Effects



This will add a paper texture over the comic book itself, simulating such things as a blue-lined grid pattern , weathering or grains in the page.



Background Color Solid Color: This allows the user to choose one color to have as the one background for the reader area. If you would like to always have the comic surrounded by black, for instance, you can choose that here. There are a total of 140 different color options.
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List Layouts Introduction Every list in ComicRack™ can have its own List Layout. A layout contains options for viewing, arranging, grouping and stacking comic books. Different situations require different List Layouts. The comic book views have a number of options that are fully customizable and can be arranged in a number of ways. Sometimes you may want detailed view with columns, while for some lists, thumbnails view may work better. You may wish to increase or decrease the size of the thumbnails or tiles or rows (details view). You may group / arrange / stack them with the metadata fields of your choice. You’re free to choose whatever suits you.



A chronological list works best when in the details view, arranged by the (sequentially assigned) alternate number field.



A zero-day list, grouped by the added field, not stacked, and arranged by publisher. Best viewed as large thumbnails, showing the series, number and publisher



A list containing series belonging to one publisher. Here, we group them by genre, stack and arrange them by series. The tiles view always displays the creator info of the series, and is very useful for such a list.



A list in thumbnail view showing the caption, name of the writer, and the file format in the 3 lines below the thumbnail.



Group by publisher, and stack & arrange by series. View as small thumbnails. Best suited for the viewing the entire library list.



A series in details view, arranged by number. Showing the following fields in the details view: number, cover, title, published, community rating. Provides at-a-glance overview of the entire series.



All these can be saved as list layout presets, so that manually changing them every time is not required. Once you save your List Layout, assign it to the list(s) you want and every time you go to that list, it will be displayed with the layout you’ve set.
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Saving List Layouts Group, arrange and stack comic books in your desired view. Next, access the List Layout options either via the List Layout icon on the library toolbar or via the Browse menu. Clicking the Edit List Layout button opens up the List Options window. It contains tabs for customizing the text shown below the thumbnails / tiles view, and the columns to be displayed in the details view. Select your required fields from the list options window, and click Ok.



All the columns that can be displayed in the Details view are shown in the List Options window. The columns of your choice can be selected here. The columns chosen in the List options are seen in the details view. You can right-click a column header to get the options for auto sizing or auto fitting the columns.



The text under the comic book thumbnails in the browser can display a maximum of 3 lines. You have the choice of selecting the text that will be displayed there. The text lines chosen in the List options are seen in the details view. Please note that these options work only for individual thumbnails and not for stacked comic books.



The text under the comic book tiles in the browser can be customized using the metadata fields available in the List options. Please note that these options work only for individual tiles and not for stacked comic books. The Icons are also best viewed in the Tiles view.



Once you are satisfied with a list layout and wish to save it for quick use later, use the Save List Layout button. Give your layout a name, and click Ok. Your saved List layouts will now be accessible through the List Layout menu. You can change the layouts using the keyboard shortcuts Alt+Shift+F6, Alt+Shift+F7, and so on.



Editing List Layouts All your list layouts can be edited using the List Layouts dialog. From the Browse menu, go to the List Layout submenu, and click the Edit Layouts option. All the list layouts are now visible along with a description of the settings that you included in each of them. Here you can make a new layout, and delete pre-existing layouts using the corresponding buttons. You can also move a layout up or down the order. The Activate button lets you change list layouts “onthe-fly”, so that you can easily visualise and choose from your favourite layouts. The Set to all button sets the chosen layout to all the lists.
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Copying / Pasting Layouts Making a list layout is easy. ComicRack™ has features supporting a number of layout customizations, so that you get the perfect layout, exactly as you desire. However, if you have a large number of lists, and you wish to assign them your favorite layout, you don’t have to repeat the same steps again and again. ComicRack™ provides for easy copying & pasting of list layouts, so that you may simply apply your preferred layouts to other lists with just the click of a button. You can access layout copy / paste options from any of two places described below: • The layout menu, which appears as a small menu on clicking on any empty space in the browser. • Right-clicking any column in the details view brings about the details context menu. Among other options, it also contains the layout menu, which contains the layout copy/paste options. Here is how to copy / paste the list layout: 1. Once you are satisfied with a list layout, use the layout menu to copy the layout of this desired list. 2. From the sidebar, select the other list to which you wish to paste the layout of the desired list. From the layout menu, select paste. 3. The layout of the selected list will immediately change to match that of your desired list. 4. Repeat Step 2 for any number of lists to which you wish to assign the layout chosen in Step 1.



1



Our desired list here has details view, arranged by position, columns manually re-sized and no grouping or stacking



2



This is the list to which we wish to apply the layout displayed in step 1. Here we have thumbnails view, grouped by genre & arranged by volume.



3



Once the layout paste action is performed, the layout in step 2 immediately changes to that of our desired list in step 1. See how it exactly mirrors the original !



?



How do I backup my list layouts ?



While ComicRack™ provides a database backup feature, it does not include your list layout presets. However, you can always manually backup your list layouts. Just follow these steps: 1. Open an explorer window and just go to: %APPDATA%\cYo\ComicRack\ 2. Copy the Config.xml file to a safe location. 3. While restoring database, paste this file back in the location specified in step 1. On restarting ComicRack™, all your list layouts will be preserved.
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Workspaces What is a workspace ? The multiple windows, panels and layouts of ComicRack™ are fully customizable and can be arranged in a number of ways. Such an arrangement is called a workspace. A workspace comprises settings for 4 features. These are Window layouts, List Layouts, Book Display Layout, and Book display Settings. While saving a workspace, you have the option of choosing any or all of these features to be included in your workspace.



You can make different workspace presets for different scenarios. You can, for example, make a workspace for times when you are simply browsing/organizing your comic books. Here you need to have the Browser window in the details view and the search browser open to get the maximum functionality. Then, to provide complete screen space to the browser, you can put the reader in dock fill mode, and open the small preview to get a good look at the selected comic book. As, in this case, you are not actively reading comic books, you don’t need to input comic display settings. You can then name it and save for quick use later. Similar to this example, an endless number of workspaces can be made, so that you don’t have to manually change the same settings everytime. Simply with the click of a button, a group of settings comes to life, saving your time and enhancing productivity.
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Saving Workspaces Different situations require different Workspaces. Manually rearranging and re-adjusting them every time is a hassle. Thus the option of saving multiple window layouts as workspaces within ComicRack™. The Workspace options can be accessed from either the Browse menu or the Tools menu. Once you are satisfied with a particular layout and wish to save it as a Workspace for quick usage later, just click the Save Workspace button. Alternatively, you may use the Ctrl+W keyboard combo to bring on the Save Workspace dialog.



• 



Window state (maximized or not, fullscreen) • Panels state, position and arrangement. For example : »» browser docking mode »» active browser tab »» minimal user interface



Book Display Layout



Window  Layouts



List Layouts



Book Display Settings



Editing Workspaces All your workspaces can be edited using the Workspaces dialog. From the Browse menu or the Tools menu, go to the Workspace sub-menu, and click the Edit Workspaces option. All the workspaces are now visible along with a description of the settings that you included in each of them. Here you can make a new workspace, and delete pre-existing workspaces using the corresponding buttons. You can also move a workspace up or down the order. The Activate button lets you change workspaces “on-the-fly”, so that you can easily visualise and choose from your favourite workspaces. The latest workspace saved can be accessed by the shortcut Ctrl+Shift+F1, and the earlier one by Ctrl+Shift+F2 and so on.
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Command-line Switches What is a command-line switch ? A command-line switch (also known as a command line parameter, flag, or an option) is an indication by a user that a computer program should change its default output. For example, in the OpenVMS operating system, the command directory is used to list the files inside a directory. When the user simply types directory, it will list only the names of the files. By adding the option /owner (to form the command directory/owner), the user can instruct the directory command to also display the ownership of the files. ComicRack™ supports a number of command-switches that modify its default configuration to the one specified by the user.



How to setup a command-line switch for ComicRack™? 1. Make a shortcut to ComicRack.exe, or copy 1 & paste a pre-existing shortcut. Right-click on this new shortcut, and click Properties. 2. Identify the Target field. The default target reads: “C:\Program Files\ComicRack\ComicRack.exe” 3. Add the command switch at the end of the default target (after the “ mark, put a space and write the command). The command switch should follow the format listed in the table below. 4. Save this new shortcut by clicking Ok. You can now rename this shortcut to help you remember the command-switch it represents. 5. Repeat these steps for each switch that you want. Please note that ComicRack™ will follow the command parameter only when it is run from this shortcut that you have created. If you do not want the switch, simply run it from the default shortcut.



2



3



In this example, we add the -ac [Config Name] command-switch to the target field. We write doc for the [Config Name] field, so the switch reads -ac doc. Starting ComicRack™ from this shortcut brings on the default ComicRack™ window with an empty library.



List of command-line switches supported by ComicRack™ Command



Description



-ac [ConfigName]



ConfigName is the name for the new configuration space. It will be initially empty (like after a fresh install).



-cp [CachePath]



To force a different cache path



-cdb



To force a database consolidation (instead of the default consolidation every 50th run)



-db [Path to Database] To force a different database path (e.g. shared databases) -dbr



Disable Broadcast: Switch to turn off network broadcasting



-dfv



Disable Folders View: to disable Folders View (if not needed or wanted)



-dso



Disable Script Optimization: Scripts are always reloaded when executed. Otherwise they are compiled once during startup



-hwd



Disables any OpenGL support



-hwf



Forces ComicRack™ to use OpenGL (even if no hardware acceleration is available)



-lm [Value in MB]



To limit the memory ComicRack™ uses



-ssc



Show Script Console: With this you get a look at all your script output (good for debugging messages)



-ws [workspace name] Force ComicRack™ to use this workspace setting at startup
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Managing This chapter introduces you to comic book metadata, which forms the basis for managing your comic book collection with ComicRack™.



Info • • • • • 



Summary Details Plot & Notes Pages Colors



Fileless comic books • • • • 



Fileless comic entries Fileless comic series Managing Fileless entries/series Catalog
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Multiple Comic Book Information
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Copy & Paste data
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Ratings



93



Reading Lists



95



Exporting comic books
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• Why rate comics ? 93 • How to rate comic books in ComicRack™? 93 • Interpreting comic book Ratings in ComicRack™ 94



• Creating export presets
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Bookmarks
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Database Backup
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▶▶ ▶▶ ▶▶ ▶▶



How to backup the current database ? How to restore a database ? What is backed up ? Good Backup Practices



98 98 99 99



Info If the Preferences dialog is the heart of ComicRack™, the Info dialog is its brain. Essential for inputting and editing comic book metadata, the Info dialog packs 5 different tabs, each of which is described in detail below. To open the Info dialog: • Right-click on any comic book in the browser and select Info, • From the Main menu, open the Edit menu & select Info • Keyboard combo Ctrl+I



Summary The Summary tab is an all inclusive box that provides at-a-glance information for your comic books, one at a time. The upper panel of the Summary tab displays essential metadata, that includes the comic book caption and the creator info along with a brief plot of the comic. This requires filling in the metadata fields (manually or via scripts) in the Details & Plot & notes tabs. The lower panel of the Summary tab displays the technical specifications for your comic book (like the file path, file format, size, number of pages, etc). The comic book caption (Format/series/ title/volume/number/year/month) and the creator info (Writer/Penciller/ Inker/Colorist/Letterer/Cover artist) The comic book cover. You can click on it to get a 3D cover, and click back to revert to this simple one.



The text that you input in the Summary field of the Plot & Notes tab will show here in the Summary tab as the comic plot.



Comic book specifications, including the size, pages and file format (zip/rar etc). This was all I needed! A summary tab!



The location of the comic book on your computer.
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Comic book ratings (on a scale of 1 to 5, with 0.1 increments) that you can assign to any comic book by simply clicking &/ or dragging on the stars here. Community ratings (average ratings from reviewers and readers around the world) are blue-colored, while ratings assigned by the user (called My ratings) are yellow-colored.



Details The Details tab is the key to inputting the comic book metadata that forms the basis of organizing your comic book collection. Just like tags in a music file, comic books can contain a variety of metadata. While ComicRack™ supports scripts to automate this process from online databases, you always have the option to fill in every detail manually. All you need to know about the Details tab is given below. Essential information regarding the series name, volume, number (n of total), month & year. The title is the name of a particular issue of a series. You can usually find the title within the first few pages of a comic.



The comic book Format can be selected here. This includes Annual, Giant, One-Shot, Trade paperback, etc. You can also add your custom formats here.



Select Yes here to mark a comic book to be belonging to a series that has now completed its run.



Use the Alternate Series field for crossovers (like Blackest Night) or story-arcs (like Sinestro Corps war) or for storylines (like Batman: reborn). The number field helps in making a chronology. A smart list based on these fields brings up the complete event in a go.



Choose the Age Rating here from among All ages, explicit ,T+, A, Parental advisory.



Essential information regarding the comic book creators. Writer, penciller, Inker, colorist, letterer, cover artist, and editor. Helps in organising all comic books by, for example, a particular writer.



Select Yes here to mark a comic book as Manga. Choose Manga (Right to left) to switch ComicRack™ to its manga reading mode when this book is opened. Not selecting anything here marks a comic book as manga is unknown. If required, you can choose the comic book Language here.



Here you can choose one or multiple genre for your comic book. Read in detail about it on the next page.



Use the Tags field for any custom metadata that doesn’t have fields in the Info dialog, like scanners’ name, series status (ongoing, completed, mini-series), scan type (c2c, noads) etc.



?



Essential information regarding the Publisher (and imprint, if any). You can then arrange or stack comic books in the browser by the “publisher” field.



The Previous and Next buttons are used to navigate between the Info dialogs of the previous and next comic books open in the the browser respectively. So, in this case, you don’t have to close and open the info dialogs repeatedly.



Select Yes here to mark a comic book as Black & White. Not selecting anything here marks a comic book as Black & white is unknown. The Proposed Values button is used for metadata auto-discovery that ComicRack™ does by processing filename. It’s there for convenience, so those fields wouldn’t be empty by default. You can commit them permanently (for example with the Commit proposed values script) or hide them, if the guess is wrong.



Is there any way to leave the ‘Series’ field blank? I’ve tried deleting it manually, but it appears again after the field loses the focus. You just have to switch the Proposed Values from Yes to No. Then validate the change by clicking on Ok which will close the info window. When you will open the info window again, the series field will be blank and you will be able to specify whatever you want.
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There are 3 types of metadata fields in the Details tab, all of which can be filled either manually or via scripts: 1. Text fields: have to be filled with relevant words or numbers. These include fields like Series, Title, Volume etc. 2. Menus: drop-down menus, where you select from an already-present list of choices. a. Simple list: Apart from the default choices, any user-inputted word is also stored in the list and shows up in the drop-down b. Yes/No menus: You can only choose Yes or No from the drop-down 3. Option fields: Here you can select more than one option. Just like the text menus, apart from the default choices, any user-inputted word is also stored in the list for re-use later. Just click the Add item button at the end of the field box to open the Add item dialog, which contains 3 tabs placed at the bottom: a. Lists tab b. Check tab c. Text tab 3



3a



The Lists tab of an Options field
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2a



2b



Add Item button



3b



Double-clicking on an entry selects it and shows it in the box above. Double-clicking on any entry in the box removes it. You can also use the < < button to bring all entries in the box en masse, the > > button to remove all entries from the box. Single-click on any entry followed by the < button brings it in the box, and the > button takes it out of the box. Click anywhere outside the tab to close it.



1
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The Check tab of an Options field



Here you get checkboxes for each entry. Just select any number of entries you desire, and then click anywhere outside the tab to close it.



The Text tab of an Options field



The most simple one. Meant for users who like to use the keyboard more than the mouse. Just type in the names separated by commas , and then click anywhere outside the tab to close it.



Plot & Notes The Plot & notes tab complements the Details tab. While the details tab contains metadata fields which are essential for organizing your comic books, the Plot & notes tab helps complete the metadata, specially to satisfy advanced comic book enthusiasts! Metadata fields like Characters, Teams and Locations bring on a large number of possibilities regarding the comic book grouping in the browser. An overview of the Plot & Notes tab is shown below.



The summary field should be filled with a brief text that highlights the plot of the comic book. The text here shows up in the summary tab as well as in reader tab bar tooltips. Input the teams (like Justice league, Avengers, etc) here. Helps in grouping/ stacking by the Teams field, or in making smart lists.



Input the characters (like Wolverine, Batman, Deadpool etc) here. Helps in grouping/stacking by the characters field, or in making smart lists. You may use Notes for whatever purpose you wish. If there’s some data about comic that doesn’t fit anywhere else, but you still want to save it, notes can be right place for it.



Input the locations (like Gotham city, Metropolis, OA, Asgard etc) here. Helps in grouping/stacking by the Locations field, or in making smart lists.



The web address of the comic book goes here. This shows up in the summary tab as well as when you click the arrow mark next to the comic book name in the details view of the browser.



?



How do I completely remove the tags? I’ve already tried doing it manually in the details tab, but the same old tags get put back up. The trick is to remove the tag not only from the tags field of the details tab but also the notes field of the plot & notes tab. You can clear the tags AND notes in the Multiple comic book Information dialog. Check them both and clear the contents (if any).
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Pages The Pages tab in the Info dialog shares a lot of similarities with the Pages Browser (see Chapter 04). Just like the pages browser, the pages tab also has the Pages context menu and the Page browser context menu (called the Pages tab context menu here).



The Pages tab context menu provides options for viewing, arranging, and grouping the pages.



Drag & drop individual pages to change the page order. Doubleclick a page to open it in the Colors tab.



The Previous and Next buttons are used to navigate between the Pages tab of the previous and next comic books open in the browser respectively.



Right-clicking on any page in the Pages Tab invokes the Pages Context Menu. This contains options for changing Page Type, Page Rotation, Adding / removing Bookmarks, reordering pages within a comic book, copying page(s) to another location, selecting & refreshing, and deleting pages from ComicRack™.
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The Reset button brings back the default values for the page attributes.



Opens up sub-menus for Changing the Page type and the Page rotation.



Colors The Colors tab is used for adjustment of the intensities of the color attributes of the comic book pages, viz. Saturation, brightness, contrast, sharpening and gamma. • • • • • 



Saturation: The “purity” of a hue; or, more precisely, the intensity of one color channel relative to the intensity of the other color channels Brightness: The relative lightness or darkness of an image, or of a particular color in an image Contrast: The relative difference between lightness and darkness in an area of an image Sharpening: An image effect that is used to adjust the image contrast by enhancing the definition of the image edges Gamma: Gamma affects how a computer generates images. An effective gamma rating will deliver true colors and a good range of light, middle, and dark tones.



Find a white spot (usually text bubble background) and double-click on it and it’ll manually adjust the other colors relative to the color at the spot you clicked such that it is balanced. This is really most applicable to poor scans of discolored books to adjust yellowing. Good scans of new books should require very little white-point adjustment.



The First, Previous, Next,and Last buttons are used to navigate between the Color dialogs of the respective pages of the book whose Info dialog is currently open.



Saturation decreased to -100%



Brightness decreased to -25%



Contrast increased to +50%



Click the Image Control button to slide open a panel containing the color attribute settings.



Gamma increased to +50%



The Image Control panel contains sliders for changing the attributes for brightness, contrast, saturation, gamma, and sharpness. Drag the sliders right/left to get the desired effects.



Click the Reset button to bring back the default values for the color attributes.



Sharpness increased to +4
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Fileless comic books ComicRack™ also supports ‘Fileless’ comic entries into the database. This way ComicRack™ becomes a full blown “paper” comic database management tool. Here are some of the scenarios in which you may find this feature quite useful: • If you wish to delete a comic book (or comic book series) from the database (for saving hard disc space, or removing a comic book that you didn’t like), but want to retain the info • If do not have some comic books in your digital collection, yet want the respective info in ComicRack™, you can make dummy entries for such comics (or comic series) • If you wish to purchase some comic books (a wishlist), and would like to catalogue their metadata in ComicRack™ for quick reference



Fileless Book Entries Working with fileless comic book entries is easy. Here are the steps you need to fol- 1 low to create your own fileless comics: 1. From the File menu, select New Fileless Book Entry 2. A blank Info dialog box will open 3. Add the relevant metadata in the details and plot and notes tab 4. In the Summary tab, you can click the thumbnail button, and browse to the comic book cover saved (manually by you) elsewhere on your system. Thereafter, even if you delete the cover from your system, Comicrack™ retains the thumbnail. Alternatively, the excellent scripting system of ComicRack™ makes it possible to scrape (from the internet) comic thumbnails (as well as metadata) for file-less entries. Please read the section on Comic vine scraper in the Scripts chapter to know more. 5. Similarly, you can use the link to file button to browse and link a file of any supported format (like CBR, CBZ etc) on your system, thus converting the file-less entry into an actual comic book. 2



3



The blank Info dialog resembles the comic book Info dialog a lot, but has minor differences. The Pages tab, for obvious reasons, is not seen.
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Enter the relevant metadata for your comic entry just like you would do for a comic book.



4



Add thumbnail and/or ratings to your comic entry. Double-click a fileless entry to open up its Info dialog.



Fileless Book Series Adding file-less entries for a large number of comic books can be timeconsuming. ComicRack™ supports adding all required issues of a series in a go.



1



Here are the steps you need to follow to create file-less comic book series: 1. From the File menu, select New Fileless Book Series. The New Fileless Book Series dialog box will open. Add the name of the series, number (range), and volume (if any)



The New Comic Book Series dialog contains the fields for series, number, and volume. The Volume field is optional.



2



3



2. Click OK to get the entire series (with the issue numbers you specified) in the browser. 3. You can now edit them (and add thumbnails/ratings) either en masse, or individually like separate file-less comic entries.



Managing Fileless entries/series Managing fileless comic entries/series is more-or-less similar to their real counterparts, the comic books. Once you add the relevant metadata, the file-less entries/series are added to the ComicRack™ library database. Essential ComicRack™ features like lists, copying/pasting data, search, browser views/navigation are the same for the file-less entries. For evident reasons, features involving comic book pages are not supported. This includes the export function, bookmarks, pages browser, a number of scripts, and most obviously, the reader! The forthcoming sections will make these features more clear. Its is also possible to convert your comic books into fileless book entries. You will need the Convert to fileless script for this. Just select the comic book (s) that you wish to convert to fileless and click the script option from the right click automation menu. Please read the chapter on scripts to know more. This operation will retain only the metadata and the fileless thumbnail, while deleting all the book pages.



?



How do I quickly find all the fileless comic entries in my library ? The Views button on the browser toolbar has the Show  only  fileless entries option. Clicking this option filters the current list and shows only the fileless entries present in that list. Using this option on the entire library shows all your fileless comics.
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Catalog The Info dialog for the fileless comics contains an additional tab labelled Catalog. This is a very useful field when it comes to managing your ‘paper’ comics. It contains important information about the comic condition, price, store, owner, collection status and more. An overview of the Catalog tab is shown below. Here you can input the price of the comic.



Name of the comic book store or website from where the book was purchased



Classification of the comic book into its respective age or historical era.



The ownership status of the comic, which could be self, friend, bookstore, etc. The location of the book in your (physical) library.



Grading the condition of a comic book based on its current physical state.



Here you can enter the ISBN code for your book.



The collection status of an issue, which can be for sale, wanted, on order, etc Here you can enter the number of pages for your fileless book. If needed, the spin buttons can be used to increase/ decrease the page count.



?



Can I get the Catalog tab for all comic books ?



Yes, the catalog tab can be used with all your comic books, and is not just limited to fileless comic entries. However, by default, it is active only for fileless entries. Follow these steps to use it throughout ComicRack™: • Open the Preferences dialog and go to the Behavior tab • From the Application section/sub-tab, uncheck the Show catalog fields only for fileless comics field. • You can now access the catalog field even for normal comic books
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Multiple book Information So far, we have discussed filling the metadata for individual comic books. ComicRack™ also supports batch processing of multiple comic books for inputting and editing metadata. This is accomplished through the Multiple book Information dialog. To open it, select multiple comic books and open the Info dialog as you would do for a single comic book. The Multiple book Information dialog contains metadata fields of both the Details tab and the Plot & notes tab of the Info dialog arranged in separate sections/tabs. The Catalog field is also present in the The Multiple book Information dialog for comic books as well as for fileless comic entries. The Multiple book Information dialog contains 3 types of checkboxes, which are interpreted differently with regard to the type of the metadata field:



For text fields or menus (yes/no, simple list): ▶▶ Value is identical in all books: Checked ▶▶ Value is different for at least one book: Unchecked For option fields: ▶▶ Value is identical in all books: Checked ▶▶ Value is different for at least one book: Indeterminate ▶▶ No value will be set: Unchecked Double clicking anywhere on the Multiple book Information dialog background toggles between the scroll (different sections in a single scrolling window) and the tab (options arranged in their own sub-tabs) layout. It contains sections/tabs titled Main, Artists/People involved, Plot & Notes, and Catalog.



TIPS Search Wikipedia from within ComicRack™ • • 



Right-click inside any metadata field to bring up the context menu with the wikipedia search results at the top Click the arrow mark next to the comic book name in the details view of the browser. You will get both the wikipedia search results as well as the comic book web address that you input in the Web field (Plot & notes tab)
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Copy & Paste data The Paste Data feature helps you to manually transfer the metadata from one comic book to another, without needing to import the data anew. Examples include replacing comics with those of better quality, or those with additional pages.



For example, here are two comic books; the original, and a new one with the complete pages. You would not want to manually input the data for the new one, as you already have done it for the original one. Here is where the Copy data & Paste data options are useful.



1



3



To add the data to the new comic, rightclick on the original comic book in the browser window and select Copy Data



2



Then right-click the new comic and select Paste Data



This will open the Paste Data dialog box. There are three options; All, which will add a check to every data item, Only Set, which only select those items that actually have data, and Clear, which will uncheck all data and allow you to only select those items you wish. It contains sections/tabs titled Main, Artists/People involved, Plot & Notes, and Catalog.



Double clicking anywhere on the Paste Data dialog background toggles between the scroll (different sections in a single scrolling window) and the tab (options arranged in their own sub-tabs) layout.



Select Ok, and all selected data will be added to the new comic book. The data can be added to as many issues as are selected. Please note that this feature will not transfer bookmarks.



The Paste Data feature is also useful when you have a number of comic books that are supposed to have similar metadata (like different issues of a series having a common creative team, the same publisher & the same genre), but you have the metadata filled in only for one, or a few, of those comic books. In this case, you can simply use the Copy Data option from the comic book with the maximally complete metadata present, and select the rest of the comic books and select Paste Data. Most often than not, ComicRack™ itself will ‘intelligently guess’ your desire & keep only the relevant metadata fields checked. You can make yourself doubly sure by unchecking metadata items you do not wish to paste.
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Ratings Why rate comics ? Chances are you like all the comic book you have in your ComicRack™ library, or else it wouldn’t be there. But there are always some comics that you like more than others. You can rate all these comic books on your ComicRack™ on a scale of 0 to 5, with 0.1 increments. But why would you want to do that? If you’ve got a large library, it’s going to be a lot of work. Well, there are a few reasons to rate your comic books: ▶▶ To create Smart Lists Smart Lists are a kind of automatically created comic book list that ComicRack™ can generate based on criteria you create. One kind of Smart List that can be created is based on the rating assigned to comic books. As a result, you can create a Smart Playlist that includes all of your 5-star rated comic books, and automatically adds new comic books to the list as you rate them 5 stars. Similarly, if you wish to delete a comic book (or comic book series) from the library that you didn’t like, but still want to retain the info, you can list all the 1-star (or lower) rated comic books, and convert them all to fileless entries. ▶▶ To compare your ratings with community ratings Art lies in the eyes of the beholder. Everyone can interpret a piece of art in a different manner. Art lovers like to interact and share each others’ views. The internet has made the world so small that we are lucky enough to receive the views of people who are much learned/experienced in certain fields than us. ComicRack™ provides both your and community ratings at the same time, so that you may see how your ratings stand with that of the rest of the comic lovers and reviewers.



How to rate comic books in ComicRack™? 1



2



3



From the Info dialog, you can find the My Rating & Community Rating fields in the Summary tab. Click and drag your mouse across the stars till you reach the point where you want to stop. The corresponding numerical rating will be displayed in real-time in the box on the right side.



4



From the right-click Browser context menu or the Reader Context menu, go to the My Rating sub-menu and click at the stars. If you want to give incremental rating, you can drag across the blank stars present at the bottom. The corresponding numerical rating will be displayed in real-time in the box on the right side. From the details view, after selecting the my ratings and/or community ratings columns, click on the stars to rate your comic books.
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Interpreting comic book Ratings in ComicRack™ Community  ratings are average ratings from reviewers and readers around the world, while ratings assigned by you are called My  ratings. Both these ratings can be viewed simultaneously in ComicRack™. Based on your preference (from the Behavior button of the Preferences dialog), the ratings on the comic book thumbnails can be displayed either in a numerical manner (at the bottom right of the thumbnail), or as rating stars (at the top left of the thumbnail). Community ratings are also displayed similarly. The community ratings are blue-colored, while ratings assigned by you (My ratings) are yellow-colored. Here is a suggested rating scale for those wishing to use it: • • • • • • • 



0.0 - 0.9 = Terrible (Burn It) 1.0 - 1.9 = Poor (Avoid It) 2.0 - 2.9 = Mediocre (Pass It) 3.0 - 3.4 = Decent (Check It) 3.5 - 3.9 = Good (Must Read) 4.0 - 4.4 = Great (Buy It) 4.5 - 5.0 = Outstanding (Must Have)



Rating stars are displayed below the comic book thumbnail or tile.



Numerical rating is displayed in the lower right corner of the comic book thumbnail or tile.



Rating stars are displayed after selecting the my ratings and/or community ratings columns in the details view.



A lot of popular resources on the internet provide reviews and ratings for all the comic books you read.



?



Can I enter ratings manually (using the keyboard number keys) ? You can. You would require the Insert Rating script for this purpose. This script allows you to insert a 5-point rating via the keyboard instead of clicking on the stars. It is explained in detail in the Scripts chapter.
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Reading Lists A Reading List is a compilation made up from comic books in your comic library. You can use lists to organize a group of comic books matching a particular criteria. All the lists are accessed from the sidebar, which, thus, is essential for working with lists. There are 2 types of lists: 1. Custom List: This is a simple list of comic books, made by manually adding individual comic books to it. This is a compilation of comic books for quick access, akin to playlists in a music player. 2. Smart List: This is an ‘automatized’ list, in which you create a rule (or many rules), and ComicRack™ automatically adds all comic books fulfilling the rule(s) to the smart list. As new comic books are added to your library, ComicRack™ auto-updates your smart lists. Create a new folder to organize your lists. You can also create folders within folders. Lists can be dragged and dropped from one folder to the other.



Use these icons to create a new custom list or a new smart list, respectively.



Custom Lists Smart Lists Add comic books to your custom list by simply dragging & dropping them from the browser window, or by clicking Add to list from the browser context menu.



Create a rule by picking a metadata field from the leftmost drop-down menu, choosing an instruction from the second, and filling in a complete or partial keyword in the third (text) field. The Sidebar with all the custom lists & smart lists



Reading Lists can be easily edited. To edit a custom list, you have to manually add or remove the comic books in the the list. This is not possible in smart lists, where editing is done by modifying the rules that constitute the list. Both custom lists and smart lists can be renamed, deleted, moved from one folder to the other, and opened in their own tab or window. You can also add any list to the favorites window by right-clicking on any list and selecting add to favorites. All your list are saved when you backup your database (see database backup section). We shall discuss all the features and functionality of lists in detail in the lists chapter.



?



Can I transfer my lists to another computer ? You can export and import both custom lists & smart lists from and into ComicRack™. Rightclick on any list in the sidebar and select the export reading list option. Save your list to a location of your choice. To import it another computer, right-click anywhere in the sidebar and select the import reading list option.
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Exporting comic books ComicRack™ has many options to export comic books. To convert a comic book to another format, right-click on any comic book in the browser, goto Export comic books and simply choose your format. A batch of comic books, or even your complete library can be batch converted in a similar fashion. Choose the export location. You can select multiple comic books and choose to combine them during export. You may also choose whether you wish to keep the original comic books, or delete them after export.



Similar to other ComicRack™ dialogs, double clicking anywhere on the Export comic books dialog background toggles between the scroll and the tab layout. The scroll layout shows all the export options arranged in different sections in a single scrolling window. The tab layout has these very options arranged in their own sub-tabs.



The exported comic book can be named according to its preexisting filename, or the comic caption (which is the standard format used by ComicRack™ for naming comic books) or your custom choice. Choose the file format



Choose the page format.



Choose compression



Choose resizing options.



You can select from this drop-down menu which page types you wish not to include in the exported comic book. Please read the chapter on Browser to know more about page types. You can choose to split double pages to 2 single pages each during the export.



If you wish, you can modify the color attributes of the comic book pages to your liking. Available are options to change the saturation, brightness, contrast, gamma and sharpening attributes of the images.



Creating export presets You can also create your own presets for easy repetition of specific export settings. To create a preset, first open the Export comic books settings menu and then set any settings you want your preset to have. After you get the settings to your liking, click the Save button and give your preset a name. The preset will now show up in the right-click→Export comic books menu. Included are presets for CBZ, CB7 and PSP.
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Bookmarks ComicRack™ contains features for bookmarking your comic books at any (and any number of) page(s) that you wish. A page can be bookmarked using the Set Bookmark option, which can be found here: • Reader window: From the Bookmarks sub-menu in the Reader context menu (after right-clicking any open page) • Info dialog: Right-click on any page in the Pages tab • Edit menu: From the Bookmarks sub-menu 1



3



2



From Reader window



From Edit menu



From Info dialog



Bookmarks are, in their simplest form, needed when you have to quit reading a comic book and you wish to continue reading from the page you left it at. So you bookmark it and next time you can easily access it. Please note that for this purpose ComicRack™ already has the Open the book at the page where it was closed option. We recommend bookmarks for more intuitive scenarios like: • As chapter jump points • To mark backup features (or second-third-fourth-etc stories in Annuals or King-Size editions) • If you combine multiple comics to one with export, the beginning of each comic book is marked with a bookmark.



The bookmarks menu in the reader window displays all the bookmarks for the open comic book. Every bookmark can be given an individual name, for example, as in this case, the chapter name.



The Pages browser showing the comic book pages grouped by bookmarks. See how comfortable it becomes to recognise them in this scenario.
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Database Backup Always keep a backup ready !



Once you have completed entering all the metadata, bookmarking your comic books, adjusting the colors, rating them, making lists, you wouldn’t want all the effort go in vain just because of an accidental deletion, a virus attack, or a software or hardware failure. ComicRack™ provides for a quick and easy back up of your comic book database. It is a simple file copy of the ComicRack™ database (ComicDB.xml) file, available for storage in a separate location from the original. The database backup options can be accessed through the Preferences dialog: Edit → Preferences → Advanced → Database Backup



How to backup the current database ? 1



2



An explorer window will open, where you can browse to the location of your choice and then click the save button. The database will be saved with the name ComicDB Backup along with the date of saving the database.



From the Advanced button of the Preferences dialog, just click the backup database option.



How to restore a database ? 1



From the Advanced button of the Preferences dialog, click the restore database option.
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2



An explorer window will open, where you can browse to the location of your saved database. Select the desired database and then click the open button, or simply double-click the saved database.



3



On closing the Preferences dialog, ComicRack™ will prompt you for a restart. Click the restart button to complete the database restoration.



What is backed up ? Absolutely all the metadata is backed up by the Backup database feature, including: • Comic-related metadata: all fields in the Details tab & Plot & notes tab of the Info dialog • Non-comic metadata: literally everything, including properties of every single page of the book, page type, rotation, bookmarks, last page read, date added/opened, rating, color adjustment, file modified time, file creation time etc. If only had I made a • Lists (both custom lists & smart lists), together with their individual layouts Backup... If Only..



The following features are not backed up by the Backup database feature: • Workspaces • List Layout presets • Options from preferences dialog • Export presets



Good Backup Practices



Backup to a remote location & backup often Backup your database to a safe and remote location; either a USB drive, or an free online backup server like box.net or dropbox. Also, make a habit of backing up your database often. A weekly backup is recommended. However, your backup frequency should depend on how often you modify the info of your library comic books, and how often & how many new comic books are added to the library.



Maintain your comic book folder structure Just be sure to put all your comics files back into the same main folder they were in before when you restore. So if they were in C:\Comics then that’s where you need to copy them after you reformat. As long as the content of the file is the same as the original one, its name and sub-folder can be different. On the other hand, if the file path and name is identical as the original one, the content of the file may be different.



Manually backup the Config.xml file Please note that the database backup does not include your preferences, export presets, list layout presets & workspace presets. So, if you would wish to backup them also, you would have to do so manually. Open an explorer window and just go to: %APPDATA%\cYo\ComicRack\ Copy the Config.xml file to a safe location. While restoring the database, paste this file back in this location. On restarting ComicRack™, all your preferences & presets will be preserved.
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Lists This chapter introduces you to lists, which form the quickest way to access a set of comic books based on the metadata present. Essential reading for ComicRack™ users !



Introduction



• Custom Lists vs. Smart Lists



Custom Lists
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• Create a new Custom List • Making comic book chronologies
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• Create a new Smart List • Smart List Basics
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Smart Lists



Working with Lists



▶▶ Open a list in its own tab / window ▶▶ Duplicate current list ▶▶ Edit a smart list (change its rules) ▶▶ Delete a comic book from a custom list ▶▶ Delete a list • Working with reading list folders • Export (or backup) Lists ▶▶ Exporting basics ▶▶ How to export lists • Import Lists ▶▶ Importing basics ▶▶ How to import lists
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Introduction By default, all your ComicRack™ comic books are located in the (virtual) Library folder. As time passes, managing your comic book collection can become quite difficult without some form of organization. This is where reading lists come into play. A Reading List is a compilation made up of a list of books from your ComicRack™ library. These are analogous to playlists that you make in your music player. You can make as many reading lists as you want and give them any name you desire. It is useful to organize comic books into lists to suit a particular reading style or mood. Not only will your comic book collection become more manageable, any group of comic books matching a particular criteria will then be just a click away.



Custom Lists vs. Smart Lists Once you reach a few gigabytes of comic books, lists and smart lists become an essential tool to keep your comic book collection manageable and enjoyable. In the sidebar, custom lists and smart lists can be easily differentiated by their distinct icons. However, the difference between custom lists and smart lists doesn’t stop at their icons only! Custom Lists



Smart Lists



Custom Lists work great if you want to group a set number of comic books together. You have total control over what comic books get into the list. Great if you know exactly what you want.



Smart lists are based on criteria of your choosing. Smart lists will scan your entire library to find whatever matches your criteria.



A regular custom list always contains the exact comic books you manually added to it.



Smart lists are automatically updated as new comic books are added to your ComicRack™ collection.



Individual comic books can be added or removed from custom lists whenever and as many times as you wish.



Manually adding / removing individual comic books in smart lists is not possible, because smart lists are bound by the rules you specify.



Deleting a comic book from a custom list only removes the refer- Deleting a comic book from a smart list removes the comic book ence to the comic book from the list. from the library itself! Both custom lists and smart lists can be exported & imported, renamed, added to favorites, opened in their own tab / window, organized in folders / subfolders, and obviously, deleted.



TIPS Keep your Sidebar ‘On’ All the reading lists (custom lists as well as smart lists) load in the sidebar. If you have toggled the sidebar off, you will be able to access only recently viewed lists through the back/forward buttons on the browser toolbar. Moreover, if you have selected a list first & then toggled off the sidebar, you won’t be able to access your complete library till you bring back the sidebar and select the library folder. So, it is highly recommended to keep your sidebar ‘on’. For more details, read the section on the sidebar in the browser chapter.



Sidebar On



Sidebar Off
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Custom Lists In its most general form, a custom list (often simply called a ‘list’ or a ‘regular list’ or even a ‘reading list’) is simply a list of comic books. Custom lists are virtual folders that you can create to ‘filter’ different types of comic books. Regular lists are just that: folders. But ComicRack™ also supports Smart lists: these are intelligent folders which can keep their contents updated, following some conditions you create. These smart lists will be discussed in the next section. This section will introduce you to the regular and simpler custom lists.



Create a new Custom List 1. To create a new custom list, either click the new list icon on the sidebar toolbar, or choose New List from the Sidebar context menu (appears on right-clicking anywhere inside the sidebar). 2. The New List dialog box opens up. Here you can give your new list a name. 3. Your New List shows in the Sidebar. It can be dragged up or down the lists, or in or out any folders. 4. The new list is empty; adding comic books to the list can be done in 2 ways: a. Drag the comic books from the Browser and drop them on top of your list. You can drag & drop them either one by one, or selecting multiple comic books in the browser (using the Ctrl key). b. Alternatively, you can right-click any (or a group of) comic book(s) in the browser to open the browser context menu, and goto Add to List. Select from names of all the reading lists in your library. Alright. Let’s make some lists!



1



The New List icon on the sidebar toolbar.



2



The new list dialog



3



The New List showing in the Sidebar.



4a



4b



Drag & drop to add new comic books to your list



Use the Add to List option to add comic books to your list
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Making comic book chronologies using Custom Lists Custom lists are best suited for organizing chronologies of comic book events. To demonstrate the power of custom lists, we made a demo list for Siege, a recent comic book event. Free preview pages were used to make the demo comic book files shown in the list. Here is how to use custom lists for making comic book chronologies: • • 



• 



• • 



• 



Select all comic books belonging to a particular crossover / storyline and then add them to the list. Select this list in the sidebar, so that all the comic books in this list are now visible in the browser window. Now, we have to arrange them in chronological order. Here the Alternate number field in the Info dialog comes to play.



For each individual comic book in the list ,you will have to input a numerical value in this field to help ComicRack™ decide the chronological order of the comic books. Here you can use the Autonumber wizard script for numbering. The Alternate series number should not be confused with the series number. Select the details view in the browser. If not already selected, right-click on the details columns and select the Alternate number field to be displayed. Drag the column to place it on the extreme left. Now, click on the alternate number column title to arrange the comic books in the list according to it. You can now view the comic books in the chronological order anytime by clicking on the list in the sidebar.



Any Custom list you already created can also be changed later on: rename it, add or remove comic books from it. You can, of course, delete an old custom list, and backup or export your lists out of ComicRack™. These topics are discussed in detail later in the Working with lists section. Disclaimer: This list is for demonstrational purposes only and in reality does not contain the actual comic books shown here. We used the freely downloadable comic book covers and preview pages for the respective comic issues displayed and saved each of them as a small cbz file. The list is made of these cbz files.



?



How can I quickly access the lists I use the most?



If you have lists that you use very frequently, you can have them displayed in the favorites window. Just right-click on any custom list (or smart list) and select add to favorites. Your list will now show in the Favorites panel and can be accessed more quickly. Add to favorites option in the sidebar context menu
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The favorites panel showing the added reading list



Smart Lists ComicRack™ gives you the ability to organize your comic books with Smart lists: these work much like rules in email programs (mail filters). Any comic book that matches the conditions you set out will automatically appear in the smart list. Smart lists thus consist of rules the user can define in order to create dynamic, self-updating lists of comics. ComicRack™ itself comes with seven built-in smart lists: ‘Files to update’, ‘My Favorites’, ‘Never Read’, ‘Read’, ‘Reading’, ‘Recently Added’ and ‘Recently Read’. You could, for example, create a Smart list of all comic books you rated more than four stars. Anytime you rate a comic book four or five star, ComicRack™ would automatically add it to your smart list; this cannot be achieved with a regular ComicRack™ custom list, unless you manually added or deleted some of them. Smart Lists can have multiple conditions, which limit their potential only to your creativity.



Create a new Smart List 1. To create a smart list, either click the new smart list icon on the sidebar toolbar, or choose New Smart List from the Sidebar context menu (appears on right-clicking anywhere inside the sidebar). 2. The Edit Smart List dialog box opens up. 2 Name Match All/Any rule in Library/List



3 Add a brief description of the list. This will appear as a tooltip on hovering the mouse over the list name in the sidebar.



1



Click the New Smart List icon on the sidebar toolbar.



Click this button to slide open additional options for setting up your smart list. If you do not wish to configure these additional options now, you may leave these empty to be filled up at any later time.



Select this option to show the smart list in the Quick Open box Limit by number or size



Negate rule



3. You may click the button at the end of the name row. This opens up additional options, including notes to be displayed as tooltips, showing the list in the quick open box, and setting limits. This is an optional step, and can be performed at any later time, or left incomplete.
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4. Pick a metadata field from the leftmost drop-down menu, choose an instruction from the second, and fill in a complete or partial keyword in the third (text) field. 4



Smart Lists. Is there anything they can’t do?



Clicking this button opens up a drop-down menu having options for working with multiple rules/groups. Metadata field



Instruction



Keyword The keyword can be, for example, the name of a series, character, file path, publisher, etc.



Match Value



Double-click the text/keyword field to open up the Match Value dialog box, which is used as an expression editor.



5



5. Most of the times, users feel the need to use more than one rule to specify the content they desire in their smart lists. For working with such multiple rules, click the button at the far end of the text (keyword) field to open up a drop-down menu. This contains options for making as many rules in a smart list as required. You can also make rule groups. A rule group (or simply, a group) is a compilation of a number of rules. A group can be further enhanced by the any/all option, or the negation function. Just like the rules, there is no limit to the number of groups you can make in a smart list. You can also have groups within groups (for advanced users). The rules/groups can be moved up/down, or cut/copied/pasted within the smart list, and of course deleted.
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Smart List Basics Here we explain you the basics of making smart lists, from the most simple smart lists to the relatively more complex. As a general rule, you should make your rules as open-ended as possible to optimize their matching scope; the more detailed the rule, the shorter the smart list results. 1



2



In its default state, every smart list contains one rule that will search for anywhere in “All” the comics’ data that “contains” nothing. You can change the blank keyword field to anything you like. For example, if you simply write ‘Batman’ in the keyword field and click Ok, the smart list would now display all books with Batman in their data.



3



If you only want to search for a phrase in a certain field, you can change the metadata field “All” to something else. For example if you wanted to find all the Batman titles you could set the search to be: “Series” “contains” “Batman”



5



The ! (negation) button finds the opposite of what you specify. To continue the Batman example, if you set the “!” button, the smart list would display any comics that do not contain Batman.



4



You can also change the instruction field (second drop-down menu). For example if you want to find an exact word or phrase you could change the option from “contains” to “is”.



6



If you specify Match All, then all the rules would have to be true for a comic in order for it to be displayed. If you specify Match Any, then if any one rule is true for a comic it will be displayed. Click the button next to a rule to open the drop-down menu, where you get the option to add / delete new rules to / from the smart list.



7



A number of metadata fields do not contain the keyword field. These are the fields that have a yes/no response. e.g. Manga, Series Complete, Black & White, Proposed Values, etc.



8



To create complicated and very specific rules, you can create rule groups. Click the button and add a rule group. With each group you can specify to follow all or any of the rules in the group. The example above displays a smart list designed to find Detective Comics 327-342 and Batman 164-174.



Advanced users can also make highly intuitive smart lists by employing the expression editor from the Match Value box.
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Working with Lists Your ComicRack™ lists are not fixed in stone: you can easily rename lists, delete lists, edit smart lists, create, rename & delete list folders, etc. It is noteworthy that manually adding / removing individual comic books in smart lists is not a valid option, because smart lists are bound by the rules which define them. Individual comic books in custom lists, on the other hand, are supposed to be only manually added or removed.



Open a list in its own tab / window ComicRack™ lets you open a list (both custom lists & smart lists) in its own tab or window, which eases working with multiple lists at a time. If you have loads of entries in your library (folders, lists, smart lists) and want to work with some, it is lot easier to open them as tabs (or windows) instead of clicking or scrolling around in your smart list. You can also drag a comic book(s) from a list / smart list in one tab and drop to a list (not smart list) in another tab. To open a list in its own tab or window, right-click on the list name, and choose Open in new window or Open in new tab.



Reading list open in own window



Reading list open in own tab



Duplicate current list The duplicate current list option is something different than simply copying/pasting a list. It builds a new smart list out of your current settings. If you did not make any changes, it does not create a new list. It takes into account the filters in Search Browser, Quick Search and options in Views (read / not read / reading / duplicates). Click a list (either custom list or smart list), type something in the quick search or choose a filter in the search browser. Once the filtered comic books show up, click the duplicate current list button and you will get a new list (with the same name) in the temporary lists folder, following the rules of the original list PLUS whatever extra filters you applied. This is the quickest way of creating smart lists. In this example, we filter the Siege demo list using the search browser. We select “Brian Michael Bendis“ from the writers field in the search browser, which filters the total 44 comics in the list to 14 written by Bendis. Now, click the duplicate current list button on the browser toolbar. A new smart list titled “Siege” appears in the temporary lists folder. Click edit to see what its rules are. You will find that smart list has filtered the original siege list according to the criteria we chose. If you wish to store this list, you have to move it out of the temporary list folder to somewhere else in the sidebar.
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Edit a smart list (change its rules) To edit a smart list’s rule, right-click on the list, and choose Edit. If the Edit menu item is greyed out, you are probably clicking on a standard list. Choosing Edit will open the Edit Smart List dialog box: this is the same dialog you used to create the smart list in the first place. This obviously only applies to smart lists, since standard custom lists are managed manually.



Delete a comic book from a custom list To remove a comic book (or a batch of comic books) from a custom list, select the comic book(s), right-click, and choose Remove. This will only remove a reference to the comic book from the list, not delete the actual comic book from your system. Please note that in case of smart lists, the Remove function actually deletes the comic book from the library itself.



Delete a list To delete a list (both custom lists & smart lists), simply right-click on the list you would like to delete, and choose Delete. Note that since a list contains only “links” to the actual comic books they contain, deleting a list only deletes references to these items, and none of your content will actually be deleted.



Working with reading list folders You can organize any number of lists and smart lists into well defined folders. Each non-empty folder has a “disclosure triangle” which allows you to hide or show the folder’s content. • To create a list folder: click the New Folder icon either from the sidebar toolbar or from the sidebar context menu. • To create subfolders (folders inside other folders): first click on the desired would-be parent folder, and then click the New Folder icon. • To promote a subfolder to a folder: simply drag the folder towards the left, and release once the cursor changes appearance to that of a horizontal dividing line. • To move a subfolder to another folder; simply drag the subfolder and drop it above the destination folder. All items stay inside and accompany their containing folder wherever you put it. • To move existing lists and smart lists in a folder: simply drag the list, and drop it on the desired folder label. • To create a list directly inside a folder: first click on the desired folder, and then create the list. • To move a list from one folder to another: simply drag the list with your mouse, and drop it on the new, destination folder. • To remove a list from a folder: drag the list upwards or downwards, until you get a horizontal divider; at that point, release the list. • You can rename list folders at any time, much like you rename regular folders on your computer: it will not affect the folder’s content.



Click the New Folder icon on the sidebar toolbar.



Converting a subfolder into a folder



Placing a list into another folder
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Export (or backup) Lists Both custom lists and smart lists can be exported from ComicRack™. There are a number of reasons why you’d want to export a list: first, you could export the list to import it into another ComicRack™ installation (like your laptop). Second, you can export a list to put it online, or email it to a friend, for example.



Exporting basics Exporting lists only backs up the information related to the list; exporting lists doesn’t backup your comic books. The list is exported as .CBL (which is a modified XML format) or plain .XML format, which allows to display information in a simple way, which can then be used by any application, even outside ComicRack™. Backup your exported lists in a safe location: since the exported list file is plain text, it takes very little space. As a rule of thumb, you should always have at least one backup at a remote location: either a geographically different, like a relative’s house or your office, or virtually different, like an email or FTP server. This way, if your house burns down, you will still have your exported lists to console yourself (provided you also backed up your comic book collection!).



I am looking out for good lists. Can you export some of yours?



Here’s a look at the XML of an example exported list. This excerpt displays the most meaningful “fields” of information related to comic books in ComicRack™; you will recognize them from the Details tab of the Info dialog.



How to export lists 1



2



Right-click on any list (custom list or smart list) in the sidebar and select the export reading list option. Alternatively, you can select the list and use the Ctrl+Shift+C keyboard combo.
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Browse through the export reading list window to a location of your choice and click Save.



Import Lists Both custom lists and smart lists can imported into ComicRack™. Importing a list is a quick and easy way to exactly reproduce a particular compilation of comic books without having to manually add the comic books, or adding them in a particular order.



Importing basics



Importing lists only adds the information related to the comic books added in the list; importing lists doesn’t copy actual comic books. While the process of importing either custom lists or smart lists is the same, there are a few differences. Smart lists simply match the defined criteria to the comic books present in your Comicrack™ library, and present a compilation of comic books matching that criteria. On the other hand, custom lists literally contain a list of comic books, often arranged in a particular sequence. When custom lists are imported, each comic book in the list is matched one by one in the search to find its corresponding actual comic book in your ComicRack™ library.



How to import lists You can also right-click on any list in windows explorer and select the Import comic book list into ComicRack™ option. You can simply double-click any reading list from Windows Explorer and it will be imported to the Temporary lists folder of the ComicRack™ sidebar. Alternatively, you can import lists from within ComicRack™ by following the steps outlined below. Please note that the last 2 steps apply only to custom lists & not to smart lists. 1



2



Right-click anywhere in the sidebar (preferably over the folder in which you wish to import the list) and select the import reading list option. Alternatively, you can use the Ctrl+Shift+V keyboard combo.



3



Browse through the import reading list window to a location of your choice, select the list you want to import and click Open.



4



ComicRack™ will match the comic books in the custom list with those in your library. If some comic books are not present/matched, you will get the option to still add them to your library as fileless comic entries.



The newly added list will appear in the Temporary Lists folder in the Sidebar, and can be moved up/down the order or in/out any folder. You can click on the list to access its comic books. The list will contain both the comic books that you already had in your library and those which have been added (if chosen by you during the import) as fileless entries.
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Scripts Scripts are small pieces of software that add new features and functionality to ComicRack™. Through scripts, you can execute a number of tasks with a single click. This chapter discusses all you need to know about scripts.



Scripts: Basics



• Installing Scripts • Uninstalling Scripts



115 115



• • • • • • 



117 117 118 118 118 118



Current Popular Scripts Built In Scripts Autonumber Wizard Commit Proposed Values Export Comic List Rename Files Search & Replace Web Link



Database Importer Scripts • Comic Vine Scraper • Other Scripts



119 122



• • • • 



Arturo’s New Comics Toolbox Remove Scanner Credits Scan Information from Filename Other Scripts



123 123 123 124



• • • • 



Library Organizer Duplicates Manager Convert to Fileless Other Scripts



125 128 128 128



• Next Issues To Read • Other Scripts
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• Series Info Panel • Other Scripts
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Comic Information Scripts



File & Folder management Scripts



Smart List Scripts Info Panel Scripts



Functionality Enhancing Scripts • Weekly Comic Releases • ‘Open With’ Script • Other Scripts
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129 130
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Scripts: Basics Scripts are essentially plugins or add-ons that extend the functionality of ComicRack™. With scripts, you can batch process books in ComicRack™. A number of tedious manual tasks can be accomplished with just the click of a button. This gives you more time to actually read your comic books than manage them! A large variety of scripts are currently available. The scripts are usually distributed as packaged zip files. These scripts can be freely downloaded from the Index of Scripts from the Scripts section of the ComicRack™ forum. In this chapter, we discuss the scripts divided into functional categories for your convenience. To get you started, some simple scripts are present by default in your ComicRack™ install. These are the built-in scripts, and all of these are discussed next. With such a wide variety of downloadable scripts out there, a new user can easily get overwhelmed as to which ones to use. While this is a matter of personal preference, the ComicRack™ team now makes the task easy for you by providing its own recommendations for the top-rated and popular scripts. Throughout this chapter, you will be learning in detail about the Editors’ Choice and the Popular scripts. Other scripts are also briefly discussed. Have a look below for an overview:
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Installing Scripts A ComicRack™ script is distributed as a .crplugin file. These are zip files with the .zip extension changed to the .crplugin extension. Installing a script is very easy. Please note that, after installation, most scripts require a restart of ComicRack™, and will prompt you for the same. 2



1



Simply double-click a crplugin file to start the installation process. You can also select the file and then click Install plugin into comicRack™ from the windows 7 explorer toolbar.



Alternatively, you can right-click the file and then select Install plugin into comicRack™ from the context menu.



Uninstalling Scripts Just as you install a script, uninstalling it is an easy and fast procedure . To uninstall (remove) a script: 1. 2. 3. 4. 5. 



The script manager displays the script under the heading to be installed (requires restart). Click Ok to restart and complete installation.



I can’t believe it! Why are you uninstalling my script?



Open the Preferences dialog Go to the Scripts Tab Select the script you wish to remove Click Remove followed by Ok Restart ComicRack™



?



I just downloaded a script from the forum, but it is in the form of a simple zip file, and not as the above-mentioned crplugin format. How do I install it? You are with an old Comicrack™ script, which earlier used to be distributed as a simple zip file. These are fully compatible with installation via the inbuilt scripts manager of ComicRack™. 1. 2. 3. 4. 



Open the Preferences dialog, and click the Scripts button. Click the Install button. Browse to the downloaded zip file and select it. Now you will see the script under the heading to be installed (requires restart). If you wish to install more scripts, repeat step 3, otherwise click Ok. Restart ComicRack™ and the script(s) will be installed and available to use.
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Current Popular Scripts For your convenience, we have categorized all the popular user-developed scripts for tweaking your ComicRack™ experience into 6 functional groups. The coming sections use this functional classification of the scripts to categorize them. We follow this with a description of the currently recommended & top-rated ComicRack™ scripts, along with the usage of the built in scripts. Here are the functional categories, with a brief description of each:



Database importer Scripts



Comic Information Scripts



These scripts import comic book information from an internet database. Such scripts are used when you wish to add metadata information from the web to your comic book archives in the ComicRack™ library. The ComicVine Scraper script is the Editors’ choice in this group.



These scripts modify comic book information. Using these scripts, you can get c2c/noads tags and scan Information from filename. erase first page advertisements, copy or move information from one metadata field to other, and much more.



File Management Scripts



Smart list Scripts



These scripts move,rename or delete files based on the comic book metadata. Using these scripts, you can organize, un-dupe, and convert your comic books. The Library Organizer script is the Editors’ choice in this group.



Smart list Scripts are a special category of scripts that can be used only with smart lists. On creating a new smart list, the Edit Smart List dialog box pops up. It contains a metadata field called User Scripts. Scripts used in accordance with this field are called Smart list Scripts.



Info Panel Scripts



Functionality Enhancing Scripts



Info Panel Scripts are used with the Info Panel, which is an ‘optional’ panel that opens in the browser. These scripts use the Info Panel for elegant & meaningful display of a lot of comic book related information, based on the metadata available.
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These scripts enhance the native functionality of ComicRack™. You can get RSS feeds for new comics (and save their fileless version in your library), open comic books from within ComicRack™ with your favorite programs (like WinZip), extract pages and much more.



Built In Scripts ComicRack™ comes pre-loaded with a number of scripts. This section briefly discusses these built in scripts, while the forthcoming pages discusses scripts downloadable from the ComicRack™ forum. Most of the built in scripts (and also those that you install later) can be accessed from their respective icons on the browser toolbar. Some of the scripts require going to Browser context menu → Automation.



Autonumber Wizard This is a script to renumber the selected comic books. To use the script, either click its icon on the browser toolbar, or right-click the selected comic book(s), and via the Browser context menu go to Automation → Autonumber wizard. • Number Series: changes the number field of the series accordingly • Number Alternate Series: helpful in making chronologies (see example below) • Begin at number: the starting issue number of the series being renumbered • Save total number: this will be the total count of the series



Arrange the comic books in the chronological order you want them in. Sort descending by the position field.



While keeping all the comic books selected, open the Autonumber wizard. Choose number alternate series from the drop-down menu. Begin at number 1 & also input the total count.



The series now has all the alternate number fields in order. You can now arrange them by the alternate number field.



Commit Proposed Values Proposed values are metadata fields that ComicRack™ auto fills by processing the filename. The commit proposed values is a script to make the proposed values for the comic books permanent. To use the script, right-click the selected comic book(s), and via the Browser context menu go to Automation → commit proposed values. A dialog will appear, asking for your confirmation. Clicking Write will make the proposed values permanent.



Proposed values are generated from the filenames, and are displayed in grey.



The Commit proposed values script dialog



The proposed values now appear like any other metadata fields.
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Export Comic List This is a simple script to export the list of selected comic books (or the entire library) into a csv file. You can open and edit this csv file with any editor of your choice (like Microsoft Excel).



Rename Files This is a script to rename the selected comic book filenames to the format: Series Volume #Number (of Count) (Year). To use the script, right-click the selected comic book(s), and via the Browser context menu go to Automation → Rename Files to Series Volume #Number (of Count) (Year). The file name of the selected comic books will change immediately.



The original comic book file name, as viewed in windows explorer.



The comic book file name after running the rename files script.



Search & Replace This is a script to search and replace values in selected comic books. From the drop-down menu on the top, you can select the metadata field, the value of which you would like to replace. Input the preexisting value (to be changed) in the search box, and the new value in the replace box. Click Ok and the changes will be done.



Web Link This is an Info Panel script (see later and also the sections in the Browser chapter) that displays the web link content from the web metadata field of the selected comic book’s Info dialog (Details tab). After enabling this script, switch on the Info Panel from the Browse menu. On selecting a comic book now, the Info Panel will display the web page that is set as its internet link. You can browse this page in the Info Panel just like any ordinary web page. The Web Link script is described in detail in the section on the Info Panel in the Browser chapter, while other Info Panel scripts are discussed later in this chapter.
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Database Importer Scripts Comic Vine Scraper The importance of metadata in organizing and managing comic books has been already emphasized at many places earlier in the manual. Manually filling the metadata fields for comic books and fileless entries can be a very slow and inefficient process. Neither would it be easily possible to be accurate and complete. The Comic Vine scraper scrapes (reads, retrieves, and saves) comic book information from the Comic Vine online database, and automatically fills all the metadata fields in the Info dialog. To open the scraper, select a book (or a batch of books and either click the green icon on the library browser toolbar, or Right-click → Automation → Comic Vine Scraper.



Settings The Comic vine scraper dialog pops up. If you are new to it and wish to proceed straightaway, just click the Start scraping button. If you wish to tweak the scraper to your taste, click the Settings button.



i ii



i ii



iii iv



iii



v



Clicking the Settings button open up the comic vine scraper settings dialog. It contains 4 tabs: Details, Behaviour, Data and Rescraping. The details tab contains a large number of checkboxes. These are the metadata fields that you will recognize from the Info dialog. By default, all fields are selected. You can select the fields you would like to update. You also have the buttons for selecting all or no metadata fields.



The Behaviour tab contains 5 options: i. Selecting this option lets the scraper ask only once for all comics belonging to a single series. ii. With this option on, every comic book scrape is preceded by a prompt for the series name. This comes in handy when the comic books that have to be scraped have mis-spelt file names. iii. Uncheck this option if you have a slow internet connection. However, in usual scenarios, we recommend this option enabled, as it increases the functionality of the scraper by displaying cover images of the series/issues being scraped. iv. Uncheck this option to hide the initialization dialog v. Uncheck this option to hide the summary dialog



The Data tab contains 3 options: i. Use this option to convert imprints (like Vertigo) to parent publisher (like DC). ii. Selecting this would overwrite any metadata fields already filled in the Info dialog. You also have a sub-option for not overwriting old values with empty new values. iii. Just as it can get you comic book metadata, the scraper can also fetch thumbnails for fileless comics from the internet. Select this option to allow the scraper to download and update fileless comics’ thumbnails. You also have a sub-option for not overwriting pre-existing thumbnails.
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Scraping



Once you are done with the settings, Click Start scraping to start the scraper find matches in the Comic Vine database for your selected comic books.



The scraper finds a number of matches for the series being scraped. Most of the times, the desired series would be found at the top of the list. Choose the correct series, and then click Ok to move to the next step. Alternatively, you can use the Show issues button to preview the individual issues for the desired series. Use the Search again button for a fresh search. Clicking Skip omits the particular issue from the scrape and moves on to the next in queue. The Cover art can be toggled off/on at all stages of the scrape.



This is an optional step. Clicking the Show Issues button opens the Choose a Comic Book Issue dialog, which provides the issue list for the chosen comic series. This helps in choosing an individual issue, if required. The Go Back button takes you one step back to the series list, where, if needed, a different series may be chosen. Comic vine scraper also helps you choose between variant covers for an issue. Simply click the small arrow below the issue cover and you can browse through all the alternate/variant covers of that issue present at the comic vine website. Once you are satisfied that you have correctly matched the issue at hand, click Ok. Please note that you can cancel the scrape anytime during all these steps by simply clicking at the cancel button at the bottom of the main scraper window. Watch the scraper gather details and declare that the scrape is complete. This is automatized metadata at its best.



?



While scraping a batch of comic books, how do I omit certain books from being scraped?



Write CVBDSKIP in the Tags field in the Details tab of the Info dialog. Any comic with this tag will be skipped during future scrapes, so use it with care! If you decide to skip a book while scraping, just hold down the control key when you click on the Skip button, and the scraper will automatically add a CVDBSKIP tag to your comic.
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Rescraping Rescraping is needed either when you wish to update the information on an already scraped book, or when you accidentally scraped incorrectly. Rescraping comic books becomes faster if the previous choice is saved. The Rescraping tab in the settings dialog lets you choose if and where the choice should be saved. While rescraping previously incorrectly scraped comic books, you may face the problem of the same metadata appearing again with the new scrape, even after trying to trigger a reset by deleting all the prior metadata fields. The solution is to uncheck the Use previous choice when rescraping comics option, and then scraping the comic book again. If you scraped the wrong series the first time, it will bring up the series dialog for that wrong series, but then you can just choose “Search Again” to select and scrape the right series/issue. Alternative way: Delete the tags field of the details tab & the notes field of the plot & notes tab. Switch the Proposed Values from Yes to No. See if the series field is clear, if not: Clear the series field also. Then validate the change by clicking on Ok which will close the info window. On opening the info window again, the series field will be blank and you will be able to specify whatever you want.



Language Localizations Like ComicRack™, the ComicVine Scraper is also multilingual. It is currently available in French, German, Dutch, Polish, Italian, and Portuguese languages. The scraper language changes automatically (if it can) whenever you change the language that ComicRack™ is using. In case you missed it, you can go back to Chapter 6 (page 72) to learn how to change the interface language of ComicRack™.



The Comic Vine Scraper Project The Comic Vine Scraper also has its own project page. Here you can find the latest version of Comic Vine Scraper in the downloads section. You can also subscribe to the project feeds, and input your suggestions or report any bugs encountered in the issues section. If you like this script, you may show your appreciation by joining Comic Vine and helping to build their community.



?



I turned off the initialization dialog from the ComicVine Scraper settings. Now, I can not access the settings anymore. Is there any other way to get to the settings dialog?



Other than the initialization dialog, you can access the settings in 2 ways: • From the drop-down menu of the ComicVine Scraper icon on the Browser Toolbar. • From Preferences → Scripts → Available Scripts. Now, select Comic Vine Scraper and click on the Configure... button.
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New Comic Entry Via Barcode This script adds a new fileless comic entry via a scanned barcode. It searches Google Base for series names, issues numbers and publishers are added automatically from the barcode. 1



• • • • 



2



POPULAR



3



From the File menu, select the New Comic Entry via barcode menu item. Alternatively, you may use the right click Automation menu, or the barcode icon on the browser toolbar. The Scan barcode dialog will open. Input the barcode after scanning with your barcode scanner. If you do not have a barcode scanner, you can use any webcam, or even simply manually write the code. Click on the search button to let the script search the internet for the barcode that you have inputted. Once the script completes its search, the select series dialog will open, displaying all the possible matches for your barcode. Select the series corresponding with your comic, and click at the Accept button. Your fileless comic entry will appear in the library. The new fileless entry has the series, issue and publisher fields filled by the script automatically. While you can always manually input all the remaining metadata fields, we highly recommend the ComicVine Scraper script (discussed earlier) for this purpose. Select your newly created fileless entry and run the scraper. The ‘complete’ fileless comic book entry is an excellent replica of the original.



Other Scripts Bedetheque Scraper This script scrapes (read, retrieve, and save) data for comic books or fileless entries from the Bedetheque website, the biggest comic book database in French.



Antiquariat Antiquariat enables file formats unsupported by default in ComicRack. In this way the excellent management features like library, lists or search are available for any kind of file format. • • • • 



From the File menu, select the Antiquariat menu item. The Scraping dialog will open. Click at the Start button. Once the scrape is complete, click at the cross button to exit the scraping dialog. Your scraped books will be displayed in the fileless format, as evidenced by the violet star state indicator. Right-click any of these to open the Info dialog, where you can add other details relevant to your book. You can also rate the books just as you would rate your comic books. For each file, the script adds a fileless entry in ComicRack™ with the Web field pointing to the actual file. It then scrapes google images for the filename. The first entry returned is used as the thumbnail in the ComicRack™ browser. Clicking the web link from the entry info opens the file in the default assigned windows application.



FromDucks This script scrapes (read, retrieve, and save) data for comic books or fileless entries from the Inducks website, the Disney comics database.
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Comic Information Scripts Arturo’s New Comics Toolbox Arturo’s new comic toolbox is a compilation of many scripts. It is meant for users who like to keep the name of the scanners in their comics to give them credit, or choose between c2c, noads or all those many choices. After installing the script, right-click any comic book and go to the Automation menu to get the toolbox options. • • 



• 



The scripts ScannerTagsFromName and ScanTypeFromName save the scanner name (if any) and the scan type (c2c, etc...) as tags for the comic. All this info, i.e., the scanner type, the scan type and the database reference, are stored as ‘tags’, which are not saved to the comicinfo.xml file. The next two scripts solve this problem: SaveTagstoNotes and RetrieveTagsFromNotes move tags to the notes fields & vice versa, making sure no one is duplicated, all the time respecting existing tags and notes. You can also use the Clear Notes & Clear Tags scripts for self-explanatory purposes.



Remove Scanner Credits Marks the first page as advertisement and following page as the front cover. Useful when the scanner credits are the first page. • • 



Scan Information from Filename Imports scanner names from the file name into the Scan Information metadata field of the Info dialog. Formated as Scanner:Name.



• • 



POPULAR



Under the right click Automation menu, select the Remove Scanner Credits menu item. Your selected comic books will get their first page marked as advertisement and following page as the front cover.



Select the comic book(s). From the Browser context menu, goto Automation -> Remove Scanner Credits



• • 



POPULAR



Just double-click the crplugin file to install it into ComicRack. Select the book(s), whose scanner name you wish to import into the Scan Information field. Right-click, and from the Automation menu, click at Scan Information From Filename Alternatively, select the desired books, and simply click at the icon on the browser toolbar



First page scanner credits are now removed



POPULARScan Information from filename



123



Other Scripts Copy/Move Info Copy/Move Info



This script copies or moves information from one field to another. You can either replace or append the information into the destination field. You can also specify text to replace or append into the destination field.



Convert 10-point Rating This script is specifically meant for users who like to rate their comic books on a scale of 1 to 10. While ComicRack™ supports a 5-point rating, a 10-point rating can be converted to its halved counterpart using this script.



Import Tags from Filename ComicRack does a pretty good job of guessing the tags from the file name when you scan your comic folders, but sometimes you may encounter comic books with unconventional file naming patterns. In these scenarios, this script can be used to import tags from the existing file names using a regular expression. A basic knowledge of regular expressions is required to use this script. The script will parse the path and file name, but not the extension. It also can save tag patterns for later reuse. To use the script, right-click any comic book(s), and from the Automation menu, select the Tags from filename menu item. Enter your regular expression in the open dialog box, and click apply.



Insert Rating Similar to the Convert 10-point rating discussed above, the insert rating script allows you to insert a 5-point rating via the keyboard instead of clicking on the stars. Write the 5-point rating in the dialog, and assign it either to the my rating or to community rating field.



Remove All Bookmarks Removes all the bookmarks from the selected books. Select the comic book(s) from which you wish to remove the bookmarks. Under the right click Automation menu, select the Remove all Bookmarks menu item. The script promptly removes all bookmarks from the selected comic book(s).



Remove Numbers At The Beginning Removes the numbers at the beginning of the series field. This is useful when the series name, for a file named like 0345 Comic Name #07.cbz, is picked up by Comicrack (correctly) as 0345 Comic Name. Running the script renames this as Comic Name.



Remove Spaces Removes the spaces from the beginning and end of the series field. Also has a version for the alternate series field.



124



File & Folder management Scripts Library Organizer The Library Organizer script allows for a highly customized user-specified organization (rename/copy/move) of the selected books and/or the windows explorer folders. The configuration dialog consists of 4 tabs, the user-defined settings wherein decide the manner in which the script works. First select the books on which you wish to run the Library Organizer on. Now, click on the Library Organizer icon in the browser toolbar, or Right-click → Automation → Library Organizer. The Configuration dialog will open up.



Organizer



1



You must first manually set the Base Folder which would serve as the destination for the files being copied/moved.



2



The Library Organizer provides options for organizing your comic book files into folders, as well as renaming your files. The first two tabs of the configuration dialog provide options for these. Here you first choose whether you wish for either folder organization or file naming (from the File Names tab) or both.



3



You now get to choose what directory structure or file naming pattern, or both) you would like to design. The Metadata box has options for these. The Metadata box contains a number of metadata buttons that you will recognize from that in the Info dialog. Using these metadata buttons, you can design your directory/file structure. These fields have been grouped in 3 tabs: Basic and Advanced 1&2. Take your time to familiarize yourself with the options available. Click any metadata button and the corresponding metadata field will appear in the directory/file structure field above. You can click at the Folder Separator button to separate the metadata fields to designate sub-folders. You can preview your directory/file structure by seeing the Example line. You can use prefixes and postfixes with each/any metadata field. These can include words/symbols/letters. If any fields are missing for a selected book, that comic won’t be renamed using the missing field nor any of the prefix or postfix values specified for the field. The Metadata box is the same in both the Folders and the File naming tabs. If you want both folder and file organization, you have to make the structure in both the tabs. As per your choice, the structure in the directories and file naming tabs could either be the same or different.
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The Advanced2 tab of the metadata box contains fields that can be multiple values. If you wish to choose the desired field for all issues in a single go, you can use the provided checkboxes. On adding any of these fields to the structure, a dialog box lets you confirm as to which value (amongst many in that field) you wish to use as the structure criteria.



4 Making rules is an optional step. The Rules tab has the Folder Rules & the metadata rules. In the Folder Rules, you can choose to exclude certain folders from the script action. This may come in handy when you have manually assembled files in a folder the organization of which you wish to retain. For example, chronologically arranged books belonging to a crossover event. Similarly, you can use the Metadata Rules box to create custom rules based on the metadata of the book. The Add Group option gives you options for making a group of rules (similar to what you’ve seen with smart lists). You can add as many rules you wish to allow/disallow the library organizer to work on books fulfilling certain criteria based on their metadata.



5



You can now switch over to the Options tab. The most important choice that you make here is the organization Mode. You can either Move your files or Copy them to the new location (decided by your chosen directory structure). If you first wish to find out what the results of running the script will be, you can use the Simulate mode, that will simply create a text file that will show all the generated paths and filenames without moving or copying any files. An important choice for users who employ metadata fields like tags/genre/character: In the case of an individual book which only has one tag/genre/character, you have the option will insert it without showing the selection dialog. Other optional choices here include what you wish to do with empty folders or empty metadata fields. You can also choose to copy fileless entries’ thumbnail image to the calculated path.



6
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Once you are done setting up the organizer to your choice, just click the Ok button, and let it perform the desired operation. A success message is displayed at the end.



This script is really letting me Organize fast!



Finding Duplicates with the Library Organizer



While moving/copying your files, if the Library Organizer encounters duplicate files, it notifies you so. In a way, using the Library Organizer is a good method of avoiding duplicates in your library. When it finds a duplicate, the library organizer’s duplicate found dialog provides you with 3 options: • Move & Replace: The pre-existing file in the destination directory is replaced by the new file that is being copied/moved. • Don’t Move: No change is made. Both the destination and the source files are kept where they originally were. • Move but Keep: The new file is moved from its source to the destination, but its name is appended, so that you get both the old & the new files in the destination folder.



Making Profiles You may need different structures for different categories of books. Once you have defined the file/folder structure, you can save it as a profile for quick use next time. You can save as many profiles as you need. You can also export profiles for a backup, or to share with some other user, who may import these into the library organizer. As time progresses, you will keep on adding more and more new comic books to your library. You need not make the structure and rules again and again. Making profiles is what saves you this hassle everytime. Once you have defined the file/folder structure and made the corresponding profiles, the next time you need to run the Organizer, just click the Library Organizer (Quick) icon on the browser toolbar. A choose profile box will open up. Select your profile and click Ok.



?



Oops! I made a silly mistake while running the library organizer. What do I do now?



Don’t worry. The Library Organizer comes bundled with its own Undo script. Find it in the Main menu’s Automation sub-menu. But remember, this only works on the last move operation that you did with the library organizer, and none prior to that.
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Duplicates Manager



POPULAR



Removing duplicate comic books can be a very time consuming process when done by ‘hand’, both, in Windows Explorer or within ComicRack™. This script aims to help automate that process following a simple ‘rules-based’ approach. Just make the rules (detailed below & in the script wiki), select the books in the ComiRack™ browser, and click at the Duplicates manager icon. • 



The script requires for proper function a text file (no fancy encoding) in the script directory, named dmrules.dat. Open this file in notepad. • By default, the script will not move or remove any comic, just log what it would do in the logfile. To enable the actual processing of files you need to edit the dmrules.dat file and set to true the variables MOVEFILES and REMOVEFROMLIB. • The dmrules.dat accepts a list of rules as provided below in your preferred order. • Text search related rules: These rules search for words in the comic field specified (filename, filepath, tags, notes, scan information). The last rules (text) search in all the previous fields. filename keep _words_ filepath keep _words_ tags remove _words_ notes keep _words_ scan keep _words_ text keep _words_ filetype keep _words_ • Alternate covers related rules: These rules search for strings like “(2 covers)” in the comic filename (note that “(both covers)” is parsed as “(2 covers)”). There are two options: if the all command is included, the rule will delete/move all the comics except the one with the higest number of covers explicitly included



in the filename. If the some command is used, the rule will keep all comics without that string, and only keep the one with the highest number of covers of those that do have the string. covers keep all covers keep some • Filesize related rules: Rule that keeps the largest or smallest comic. It can receive an optional parameter with the percentage of the size. This means that any comic that changes that percentage to the largest/smallest will be kept. filesize keep largest filesize keep largest 10% • Pagesize related rules: Rule that keeps the comic with largest or smallest pages. It can receive an optional parameter with the percentage of the size. This means that any comic that changes that percentage to the largest/smallest will be kept. pagesize keep largest pagesize keep largest 10% pagesize keep smallest pagesize keep smallest 10% • Pagecount related rules pagecount keep fileless pagecount keep noads pagecount keep c2c



Convert to Fileless



POPULAR This script converts selected comic books to fileless entries. This would be useful when you have read the book and want to keep track of it but consider it not worth storing on your system, or just wish to save precious hard disc space. Using this script, you can change type to fileless, delete all images in archive, and still retain the thumbnail and metadata. Other Scripts Move Files This script prompts the user for a destination folder and moves all selected comic book files to that folder. It also updates the file path information in ComicRack™ for the comic book so you don’t have to re-add them. When choosing the destination, you can elect to create a new folder as well. Existing files in the destination folder will not be affected.



2iPad Requires ComicZeal for iPad and SyncDocs. This script copies comic into the SyncDocs folder, naming the files for ComicZeal. This simplifies the SyncDocs process. Now also supports FTP.
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Smart List Scripts Smart list Scripts are a special category of scripts that can be used only with smart lists. On creating a new smart list, the Edit Smart List dialog box pops up. It contains a metadata field called User Scripts. Scripts used in accordance with this field are called Smart list Scripts.



Next Issues To Read



This script displays unread or partially read comics where the previous issue in the POPULAR series has been completely read. 1. Create a new smart list. 2. In the Edit Smart List dialog box, set the metadata field (first drop-down menu) to User Scripts and set the instruction field (second drop-down menu) to Next Issue To Read. 3. Select the smart list in the sidebar, and you now get all comic books that have the page type you specified. The script ignores any comic book that has been opened till the first 3 pages. This comes in useful when you are in the habit of opening up newly added comic books just to get a look at them. Comic books that have been read further than 3 pages are counted by the script to be significantly partially read to be displayed. However, you can change the number of pages to be ignored by editing the New Comics.py file.



Other Scripts Books With Pages Marked This is a smart list script that pulls comics that have any pages marked with the entered type. Create a new smart list. In the Edit Smart List dialog box, set the metadata field (first drop-down menu) to User Scripts and set the instruction field (second drop-down menu) to Books with pages marked. Next to the instruction field is the option text box. Here you write the Page type. Click Ok once you are done. Select the smart list in the sidebar, and you now get all comic books that have the page type you specified.



Files Not Found A simple smart list script that shows the books where the files are not found on disc. There is a second smart list to show the ones that the files are found too.



Series Count Is A smart list script that pulls series based on how many issues a series contains. Create a new smart list. In the Edit Smart List dialog box, set the metadata field (first drop-down menu) to User Scripts and set the instruction field (second drop-down menu) to Series Count Is. Next to the instruction field are the two option text boxes. In the first Text Box, enter any of the operators < (less than), > (greater more than) or = (equal to). Enter number of issues in the second text box.



Proposed Values Finds comic books that contain proposed values. To filter results to a specific field you can specify: volume, series, count, format, number, title or year.
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Info Panel Scripts Info Panel Scripts are a special category of scripts that can be used only with the Info Panel. The Info Panel is an “optional’ panel that opens in the browser, using either the Browse menu, or the Shift+F9 keyboard combo, or by clicking the Info Panel docking grip at the bottom of the browser window. However, the Info panel doesn’t show up till any Info panel script is enabled. Here we detail all the currently popular Info Panel scripts.



Series Info Panel Shows most of the available metadata of the selected book(s) in the Info Panel, without requiring to invoke the Info dialog. With the info panel enabled and the series info panel script installed, select a comic book (or a group of comic books). The Info Panel will show almost all the available metadata in a visually elegant manner.



The default configuration for the Series Info Panel. Shows best with the Info Panel docked right on a widescreen monitor. Here we see the series infopanel when a single comic book is selected.



The Series Info Panel showing a small series of 30 issues. Missing issues are displayed in red. Duplicated issue numbers are also displayed. The ‘next to read’ issue appears as a link, clicking at which opens the comic book in the reader.



The small wide configuration for the Series Info Panel. Shows best with the Info Panel docked below in its default position, especially when you wish to preserve precious horizontal space on your screen. This skin is best suited for viewing multiple series in the series info panel.



The Series Info Panel can be easily configured to suit your needs. To open the options window, from the Main menu, go to File menu → Automation → Series Info Panel Options. All the metadata fields are seen in 2 columns , one for the series view and the other for the issues view. Here you can select the fields you wish to be displayed in the Info panel.



The Skins drop-down menu lets you choose from a number of skins for the Series Info Panel. While currently, only the default and small wide skins are present, a number of skins are under development and shall be released in future versions. Move any selected metadata field up or down. Add separators between groups of fields. Using this option, you can set the script to hide empty metadata fields.



The Series Info Panel Options dialog provides for absolute user control for customizing the Series Info panel. Play with it for a while to see what suits you best !
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The Series Info Panel can display any number of pages from the selected comic book in the form of a filmstrip at the bottom of the panel. Here you can select the number of pages you wish to be displayed. Please note that this function slows the script a bit.



Other Scripts CoverFlow Info Panel This script displays a coverflow of the selected comics in the Info Panel. CoverFlow is an animated, three dimensional graphical user interface for visually flipping through thumbnails of selected comic books. Many users find it quite useful for skimming through a title for a particular issue or cover art. With the Info Panel enabled and the CoverFlow script installed, select a bunch of some comic books. You can then browse the Coverflow using the mouse wheel scroll or left/right keys. Clicking on a comic book opens it in the reader window. Please note that currently the script takes a few moments to present the coverflow of the selected comics. This also depends on the number of comics selected. So, please be patient while the CoverFlow loads and don’t overload the script with a huge number of comic books.



Metadata Info Panel The functions and usage of this script overlap with those of the previously discussed Series Info Panel. With the info panel enabled and the metadata info panel script installed, select a book (or a group of books). The Info Panel will display almost all the available metadata in a visually elegant manner. The metadata info panel shows best with the Info Panel docked right on a widescreen monitor. You can also modify the metadata info panel to suit your taste. However, this requires making manual alterations in the Comic info panel. html file, using an editor like Kompozer. Many users have already posted their own Comic info panel.html files at the forum, that can be copied & pasted in the script folder. Notable among these is the narrow version of the metadata info panel. For users who find manual editing of html files too much of a hassle, the previously discussed series info panel is the perfect solution.
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Functionality Enhancing Scripts Weekly Comic Releases Weekly Comic Releases is a recommended add-on script for ComicRack™ that gets you the latest RSS feeds about the new comics coming out each week. You can filter the results by date, title or publisher. Blacklist function to exclude results from unwanted publishers is there. You can also export the comic list to a text file or to fileless comic entries in your ComicRack™ library. 1 2



To open the script, from the Main menu, go to File menu → Automation → Weekly Comic Releases



Here you can choose the week for which you wish to view the comic releases.



From the preferences dialog, you can choose to turn off the Price, Cover and Publisher columns in the right pane of the weekly comic releases window. You can use the add button here to manually add any publisher to the blacklist. Such blacklisted entries are no longer displayed by the script in your comic book feeds.



The script immediately starts parsing the data from ComicList.com. It also downloads the available comic book covers. The time taken for this initial online operation may vary, depending on the speed of your internet connection.



3



You can filter the results by the title of the comic you want to search for. Here you can select the publisher(s) for which you want to view the comic release list. Once you get the desired comic names in the right pane, you can further select one/ few/all accordingly.



4



5 In this example, we see the comics we had selected from the above window. We exported these comics to the fileless format. We then run the ComicVine Scraper script to automatically add metadata and front cover thumbnail. You can later link them to actual comic books (cbz, cbr, etc) and get your zero-day collection updated !
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Right-click on an existing title and choose the add to blacklist option to add that publisher(s) to the blacklist. You can export all/selected titles to either a text file or to fileless comic entries in your Comicrack™ library. You can have the option of adding tags to these entries before the export.



‘Open With’ Script



This script allows you to extend ComicRack™ by adding your own “Open With” proPOPULAR gram shortcut to the right click Automation menu. Add as many items as you need by running it multiple times. When you are choosing file types, be SURE that the program you select will handle those file types, otherwise the program will probably give you a nasty error message about not recognizing that file type. 2



1



From the main menu select File → Automation → Build ‘Open With’ Menu Item... . The script will prompt you for a label and the comic book file types you want to allow be used



Browse to the location of the program with which you would like to open comic books from ComicRack™. Select the program exe file.



3



After correctly completing all the previous steps, click Ok and restart ComicRack™. Right click on a comic book, select Automation, and you’ll see “Open With Something You Typed”.



Other Scripts Create Combined Script Technology breeds technology. So, if you get tired of running script after script, this create combined script here creates a new script that simply executes several scripts one after the other on the selected comics. Find it in the File → Automation menu. It has a selection form that allows you to select what scripts you want and put them in the order you desire.



Extract All Pages This script extracts all the pages of a comic book to a user specified folder. Rather then opening windows explorer & navigating to the folder containing the comic book to be unzipped, then opening the cbz/cbr file with a zip file manager (WinZip/WinRar) and extracting the pages, it is far quicker to extract pages of selected comic books by a single click of the script button on the browser toolbar.



Extract First Page This script is a child of the previous script, and is quite similar in operation. This will extract only the first page of all selected comic books. The file name is generated based on the comic book series name, volume number, and issue number.



List Comic Files in Directory Runs outside of ComicRack. This script lists all the CRB and CBZ files located in a user selected directory and all its sub-directories. There are two version of this script: one exports the list to a txt file, the other exports to an xls/xlsx file but requires Microsoft Excel.



Write Missing Issues to Text File Writes a list of missing issue in a series to a user specified text file. It can be run on the whole library or on specific series and volume.



115



Web Comics If you like to read comics published on a website, ComicRack™ can download, save and update them for you. Read this chapter to learn how!



Web Comic Basics



• Getting Web comics ▶▶ ComicRack™ forum ▶▶ Create Web comics on your own ▶▶ Using Web comic Templates



Working with Web comics



• Alter a Web comic’s starting date • Save a Web comic for offline reading • Updating Web comics
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Web Comic Basics ComicRack™ supports Web Comic (.CBW) files. With Web Comics, ComicRack™ can read comics directly from web pages and display them as if they were standard digital comic archives (CBR, CBZ). Web Comics can be exported to other formats. If the definition supports it, a Web comic can update itself to add new pages (like for daily or weekly comics).



Getting Web comics 1. ComicRack™ forum This is the easiest way. Just login to the ComicRack™ forum and go to the Index of Web Comics. Our developers there have already posted a good collection of Web comics that you can download and use. New Web comics are regularly posted and requests for specific Web comics are entertained.



2. Create Web comics on your own Making a Web comic has 3 main steps: 1. Go with the browser of your choice to your Web comic page. Decide if you need to create a Url based (simple) or a regex based (BrowseScraper, IndexScraper) Web comic. 2. To find the regular expressions, select “View Source” in your browser and copy the html code into a regex testing tool of your choice. Play around with the regular expression. If you think you’re done, put the expressions into the Web comic file and open it with ComicRack™. 3. Please note that ComicRack™ works with the .NET implementation of RegEx. If the expression contains a link group, this one is used. Otherwise the matched expression is used. For additional information on making Web comics, please read the article on the ComicRack™ wiki page.



3. Using Web comic Templates to make Web comics A Web comic template can be easily edited to make the Web comic of your choice, which you can read (with daily updates) from within ComicRack™. Here we discuss the Web comic Template for Gocomics.com (a website that contains a large number of daily comics) and Onemanga.com (a website containing lots of manga). You can freely download the Gocomicstemplate.cbw & Onemanga.cbw files from the ComicRack™ forum.
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Please make a web comic for me!



Creating Web comics for the comics at Gocomics.com



1. 



Goto the A-Z comic listing at Gocomics.com. From quite a large number of comics, choose the comic you want to create the Web comic for. Click the name of the comic. In this example, we choose “Red And Rover”. A new page for that comic will open.



2. 3. 



Now we will choose the date from which we want our Web comic to begin. For this right-click on the double-backward arrow icon near the date. Click on “Copy link location”. Now, we have the link for the beginning comic strip for our Web comic. The link can be easily changed manually to select any date from which we would like our Web comic to begin. e.g. change the date in the link from .../2003/01/01/ to .../2010/01/01/, and we’ll get the comic from January 2010 onwards.



4. 



5. 6. 



Open the template GoComicsTemplate.cbw with any text editor you like. In this example we choose Notepad++. Your simple windows notepad will do as well. Replace the Image Url in the file with the link we copied in step 3. To save the Web comic, go to File->Save as, and replace the name with that of your choice, in this case, Red And Rover.cbw Don’t forget to choose “All types” in the “Save as type” dialog of your text editor. Your Web comic is ready. Double-click to open it with ComicRack™.



Creating Web comics for the comics at Onemanga.com



1. 2. 



3. Go to the Manga directory at Onemanga.com. Scroll down to choose the manga you want to create the Web comic for. In this example, we choose “Dance in the Vampire Bund”. Click on it and a new page for that 4. manga will open.



Now we will choose the date from which we want our 5. Web comic to begin. Usually, this would be the first chapter of the manga. For this, scroll down the chapter list to reach the first chapter (at the bottom of the page). Click on it to reach a new page. Find the link titled “Begin reading Dance in the Vampire 6. Bund 1” (or name of your chosen manga) near the bottom of the page. Right-click on this link and then “Copy link location”.



Open the template Onemangatemplate.cbw with any text editor you like. In this example we choose Notepad++. Your simple windows notepad will do as well. Replace the variable key Url value in the file with the link we copied in step 4. To save the Web comic, goto File->Save as, and replace the name with that of your choice, in this case, Dance in the Vampire Bund.cbw. Don’t forget to choose “All types” in the “Save as type” dialog of your text editor. Your Web comic is ready. Doubleclick to open it with ComicRack™, and enjoy! You have successfully converted ComicRack™ into an online manga reader!
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Working with Web comics ComicRack™ treats Web comics just like standard eComics. All features of ComicRack™ have the same level of functionality for Web comics as well. The only difference is that reading a Web comic is dependent upon the speed of your internet connection. This also depends upon the total number of Web comics in your collection, the internet cache size, and the dates from which the Web comics begin (overall size of a Web comic). In most cases, however, the individual pages of a Web comic are rather small in size & get updated very quickly.



If your file is in the Library, then the page at which you have stopped reading the web comic should be remembered so the next time you open the web comic, this last page should be displayed instead of the first page. Drag-and-drop any CBW file into the Browser to add it to the ComicRack™ library. Doubleclick it from the browser to open it in the reader window as the pages get downloaded.



Hulk likes web comics. Hulk will sit and read them all.



Double-clicking any web comic (.CBW file) from Windows Explorer opens it directly in the ComicRack™ reader and starts displaying the pages as they are downloaded from the web.



You can see the following in the Status bar: • Name of the open Web Comic • Current page • Page count of the open book
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While a Web comic is updating, clicking on the Pending background tasks indicator reveals the pages getting downloaded.



Just like with normal comic book archives, you can open up the Info dialog for Web Comics, and view and edit their metadata.



If you have downloaded a cbw file, then either save it in a folder that’s added to your Library or enable the option to add the files to your Library upon first opening: Preferences → Behavior → Opening a book



From the Details tab of the Info dialog, you cab choose whether to include a particular Web Comic in the updates or not.



137



Updating Web comics As Web comics link to comics from web pages, they need to be regularly updated to keep reading the latest pages. There are 2 ways to update: 1. Manual Updates: From the Main Menu → Update Web comics (or use the keyboard combo Ctrl+Shift+W) 2. Automatic Updates: From Preferences → Behavior → Starting ComicRack™ → Select the option Update Web comics. This way, ComicRack™ will check & download all updates for all your Web comics on startup.



Main Menu



Preferences



Alter a Web comic’s starting date The date from which the web comic file begins is in the code shown in the example alongside. So, in this case, the web comic will begin from 2010/01/01 and move on to the present day. You can change the date in the code to determine the last day till which the web comic will be scraped (or in other words, the day from which the web comic will begin). Now, you have a web comic that is updated from today till its last day, and its going to sit like that in the library. Whenever you update next, the latest page will automatically be displayed and you can scroll back to read previous pages if you wish, going backwards till you reach the last one.



Right-click the cbw file to open in a notepad or any text editor of your choice. Modify the date accordingly, and save as a cbw file. Reload the file into ComicRack™.



Save a Web comic for offline reading If you wish to save a Web comic for offline reading, just export it to a place on your computer. The Export eComics function works for Web comics with exactly the same functionality as it does for regular eComics. Please note that the Web comic would be exported only till the last page that has been retrieved from the net. While exporting Web comics, it is not recommended to delete the original pages after export, as ComicRack™ would have to download them again if you re-update it.



Right-click the Web comic from the browser and go to the Export eComics option. Choose your preset, or use options in the export dialog to fine-tune the export process to your choice.
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Click the pending background tasks indicator during the export to note the current state/progress of the export. If you wish to stop the export for some reason, click the abort button.



Network Sharing You can access remote comic book libraries of your friends and family using the network sharing features of ComicRack™. Learn more in this chapter!



Opening Remote Libraries
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Enabling Network Sharing
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• Allow through Firewall • Sharing on the LAN ▶▶ Enabling sharing on the LAN • Sharing over the Internet ▶▶ Enabling sharing via a modem ▶▶ Enabling sharing via a router
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Opening Remote Libraries Using the network sharing functionality of ComicRack™, you can open the shared library of other ComicRack™ users over the internet. In this section, we explain how to work with remote libraries, while the next section will focus on sharing your own library with other ComicRack™ users. Please follow the copyright laws for file sharing in your region. 1. Click on the Open Remote Library option either from the File menu, or from the Tools menu. Alternatively, you may simply use the Ctrl+Shift+R keyboard combo.



1



2. The Open Remote Library dialog will open. The names and description of available libraries could be seen. Also seen are the Edit and Export properties for the shared libraries. Please note that the icon indicates a password-protected library, for which you’ll have to contact its user through the ComicRack™ forum. 3. Double-click on any library name, and ComicRack™ will try to connect to the server to get information about the shared library. 4. The Shared library opens up in the Browser Tab Bar next to the Library tab, and it tries to open connection to the remote server. 2
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Hmm.. So you want to access my library? Do you have the password?



3



The Shared library opens up in the Browser Tab Bar next to the Library tab



If you wish, you can click the Cancel button at this time to sop connecting with the remote library. Once the cancel button is clicked, the Connect button appears in its place, and can be clicked any time later to start the process.
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5a 5. If the library is password-protected, you will be asked to enter the password. ComicRack™ will then retrieve the shared library from the server. In the case of an incorrect password or incorrect network configuration or a network timeout, an error dialog may announce the inability to retrieve the 6a library. 6. The remote library will load in the Browser Tab Bar next to the Library tab. Doubleclicking on any comic book will retrieve it from the user’s library and open it in the Reader. The time taken to completely download the comic book depends on your internet speed and the file size. The remote library supports all the functions of ComicRack™, just like your library. Group, arrange, stack, reorder, recolor, search shared comic books just like you would do for the regular ones. 7. Once fully retrieved, the comic book can be exported / converted just like a regular comic book of your library. Please note that this function is possible only when the shared library allows the Export facility.
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Comic books from shared libraries open just like your ‘regular’ comics. Here we see a comic book open in the reader, with all its pages in the pages browser.



5b



7



Right-click the comic book from the shared library browser and go to the Export comic books option. Choose your preset, or use options in the export dialog to finetune the export process to your choice.
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Enabling Network Sharing Now that you have learned how to access other users’ shared libraries, you would definitely like to share your own library with your family and friends. We will now discuss how you can do this with ComicRack™. This functionality has slightly different set up if used within a LAN or over the Internet. While the differences will be dealt with in the coming sections, here we discuss the common features. To enable network sharing, go to Edit menu → Preferences → Libraries tab → Sharing section → Click Add Share. Here you can also select if you want to share your complete library or only selected lists. You can also select to make your library password protected (recommended) or editable. Share selected reading lists or all your library.



Choose a name & (meaningful) description for your library.



Click the Add/Remove Share button to add/remove multiple libraries. New shares appear in tabs alongside the open library.



Choose a good password (recommended). Decide if you would like to keep your share private. Choose whether you would like clients to have editing & export privileges. Please note that if export is not allowed, they won’t be able to save the comic books. Drag the slider to increase or decrease the page quality & the thumb quality of the comic books in your shared library.



TIPS Keep your shared name same as your ComicRack™ forum username There is no way for a client to request you for a password for your shared library unless he recognizes your shared name. This is only possible if you use your ComicRack™ forum username as the name for your shared library. This way other users can PM you on the forum, and you could reply back your password to those you wish. Get password requests as private meassages on the ComicRack™ forum
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Allow through Firewall A Firewall is a Software/Hardware which checks every information coming from the internet or a network and depending upon the Firewall settings, it either blocks or allows the information to pass through to your computer. If necessary, the firewall dynamically opens ports and allows your computer to receive traffic that you have specifically requested. Typically when ComicRack™ starts for the first time, you’re presented with a popup window asking if you want to allow or block its access. Check Allow access to allow ComicRack™ to communicate on both private & public networks.



If you are using a software firewall other than that of windows, the behavior is almost similar to that of windows firewall. As ComicRack™ tries to communicate with a remote computer, most firewalls pop-up a warning message asking for your permission to allow or deny it 1. While you want to obviously allow ComicRack™ to communicate with a remote compute, you would not want to repeat the same procedure every time ComicRack™ shares its files. Most firewalls allow rule-based firewall access; click remember action / create rule (or its equivalent on your system). 2. Click Allow (or its equivalent on your system). This isn’t always the case though, and sometimes you have to manually allow ComicRack™ through the firewall to access the Internet. In this case, follow the instructions outlined below. 1. goto Control Panel → System and security → Windows firewall. Here click the option Allow a program through the firewall 2. This brings up the Allowed programs window. Click the Allow another program button at the bottom of this window. 3. The Add a program dialog pops up. Scroll down the dialog to select ComicRack™ (If you don’t see ComicRack™ in the list, you may have to browse to its installed location & then add it). Click Add & then Click Ok to close the window.
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Sharing on the LAN LAN stands for Local Area Network. It is a relatively small network within a small geographic area (like a room, an office, a building, a campus etc). Most LANs today run under Ethernet. If you connect two computers for sharing data, you have a LAN. The number of computers connected on a LAN may be up to several hundreds, but most of the time, LANs are made up of more or less a dozen machines. To connect two computers, you may only link them using a cable. If you want to connect more, then you need a special device called a hub, which acts like a distribution and link point. Cables from the different computers’ LAN cards meet at the hub. If you want to connect your LAN to the Internet, then you need a router instead of a hub.



Enabling sharing For ComicRack™ on the LAN Enabling network sharing on the LAN requires almost no configuration. Here is what you need to do: 1. Allow ComicRack™ access to your firewall 2. Enable network sharing, via Edit menu → Preferences → Libraries tab → Sharing section → Click Add Share 3. Choose from all the options as described earlier, and click Ok. 4. Restart ComicRack™ 5. Open ComicRack™ in another computer on the LAN. 6. You will see a new tab with the name of the shared Library on the Browser tab bar. Click on it to access the shared library



Using the preferences dialog to add a new shared library
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Give your share a name and a password. Choose the lists you want to share. You have the choice to allow your clients to edit/export your comic books.



The shared Library shows up in a separate tab on the Browser tab bar. Opening multiple libraries simultaneously opens each in its own tab.



Sharing over the Internet The configuration needed for sharing a ComicRack™ library over the internet depends on how you connect to the internet. You can, for example, connect to the net simply by attaching an external modem to your desktop. Alternatively, you may be connecting via a router. Here we discuss these scenarios, along with the steps required to share your library.



Enabling sharing For a PC connecting via a modem A modem is a device that can connect a computer to other computers via a conventional telephone line. Traditional modems used in dial-up networking convert data between the analog form used on telephone lines and the digital form used on computers. Broadband modems that are part of cable and DSL Internet service, use more advanced signalling techniques to achieve dramatically higher network speeds than traditional modems. The following steps are required for enabling network sharing for ComicRack™ for a PC connecting to the internet via a dial-up / DSL / cable modem: 1. Allow ComicRack™ access to your firewall 2. Enable network sharing, via Edit menu → Preferences → Libraries tab → Sharing section → Click Add Share 3. Choose from all the options as described earlier, and click Ok. 4. Restart ComicRack™ 5. Now your ComicRack™ is ready for sharing your library over the internet. Users who would like to access your library have to follow the steps outlined in the Opening remote libraries section of this chapter. If your share is password-protected, interested users may send you private messages on the ComicRack™ forum, requesting the password.



Enabling sharing For a PC connecting via a router Routers are physical devices that join multiple wired or wireless networks together. On the Internet, routers serve as intermediate destinations for network traffic. These routers receive TCP/IP packets, look inside each packet to identify the source and target IP addresses, then forward these packets as needed to ensure the data reaches its final destination. Routers for home networks (often called broadband routers) also can join multiple networks. These routers are designed specifically to join the home (LAN) to the Internet (WAN) for the purpose of Internet connection sharing. Most of the broadband routers also offer integrated firewalls.
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The router has two IP addresses. It has the external IP address, and an internal IP address which acts as the gateway for every computer on the network. When a computer inside of the network wants to send data to a computer outside of the network, it sends the data to the router. The router then takes this data and sends it out to the computer on the internet via the external IP address. The same thing is true of computers outside of the network. They can only “see” and send data to the external IP address of the router. The router must then decide what to do with this data. Port Forwarding simply tells the router which computer on the local area network to send the data to. When you have port forwarding rules set up, your router takes the data off of the external IP address:port number and sends that data to an internal IP address:port number. Port Forwarding rules are created per port. So a rule set up for port 7612 will only work for port 7612. So, if the computer sharing the library is behind a router, you will need to follow these steps: 1. Go to the Router configuration, to a section called “Port Forwarding” (or similar, varies across brands) 2. Create a new port forwarding for the port 7612 TCP, so that the External port 7612 is forwarded to the IP of the computer sharing the library. For example, if the IP of the computer sharing the library behind the router is 192.168.0.5, you will need to forward port 7612 TCP to 192.168.0.5:7612. 3. Allow ComicRack™ access to your firewall 4. Enable network sharing, via Edit menu → Preferences → Libraries tab → Sharing section → Click Add Share 5. Choose from all the options as described earlier, and click Ok. 6. Restart ComicRack™ 7. Now your ComicRack™ is ready for sharing your library over the internet. To connect to this shared library, other users have to open ComicRack™ on their computer and go to File → Open Remote Library. Enter the external IP address of the router. If the port forward is done correctly, they should see a new tab appear with the shared library name.
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Why do my friends get an error message when they try to access my remote library ? If you have a very large library and a slow connection, your clients may encounter errors when they try to access your shared library. If it happens, try sharing only part of the library instead, by going into Edit menu → Preferences → Libraries tab → Sharing section → Click Share selected lists (instead of Share All).
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Support The ComicRack™ team has its own forum and facebook page to help you in the best possible ways. But, ComicRack™ also needs your support to keep on providing you the very best! Learn more in this chapter.



Help



• Choosing the Help System
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Forum
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Facebook
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News
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Donations
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• Why donate ? • How to donate ?
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Help The Help menu (on the ComicRack™ Main Menu) contains many useful options and quick links for accessing a number of online Comicrack™ resources.



This sub-menu appears only when certain specific scripts (the ComicVine Scraper, for example) are installed. It provides a direct ink to these scripts’ webpages.



Choose the Help system you wish to use. Links to online ComicRack™ resources, including the ComicRack™ user forum.



Read RSS feeds regarding the latest ComicRack™ news. Click to open up the About dialog, where you can find which build of ComicRack are you running. Links to the ComicRack™ donate page for those wishing to support us!



Choosing the Help System ComicRack™ has 2 different online help systems. These are the ComicRack™ Wiki, and the Online ComicRack™ Manual (recommended). You can use the Choose Help System sub-menu to make either of these the default help system on your ComicRack™. 1



2



From the Help menu, goto the Choose Help System sub-menu, and select ComicRack Online Manual.



Now, you get a Help sub-menu, which contains online links for all the chapters that you have read so far! You can help other users download the ComicRack™ Manual from the link at the bottom of the Help sub-menu.
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Forum You can always find the ComicRack™ team hanging out at the forum. If you also wish to interact, just register yourself at the ComicRack™ forum (it is free and takes only a few moments), and login. You can reach the forum through any of the following: • From the Help menu, click the ComicRack User Forum option • Keyboard combo Ctrl+F1 • Click me So, What ya waitin’ for, Doc?



You can get all the latest news about ComicRack™ in the News & Announcements section. Here you can download the latest versions of the ComicRack™ software. View and download all the scripts and web comics from the Index of Scripts and the Index of Web Comics, respectively. If you are facing any problems while using ComicRack™, post it in the Help section. You may report any bugs that you encounter in the Bugs section; this helps us improve the software. You can even request any feature you would like to see in the future versions of ComicRack™ in the Feature Requests section. Reading Lists and Web Comics can be posted & downloaded from their own sections, respectively. Apart from all this, you can simply discuss comics, share user art (icons, wallpapers, etc) and much more.
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Facebook



ComicRack™ is now officially available also on Facebook and Twitter. Now you can connect with ComicRack™ on the go.. on your mobile, at your workplace.. Spread the word ! Please share this with all your facebook friends out there.



Just login to facebook, and subscribe to the ComicRack™ facebook page. This would help us increase our fanbase and support for ComicRack™. Catch all the latest ComicRack™ news on Facebook too!



To Join ComicRack™ on Facebook, just click the “Like” button. If you can’t see the button, then you’re already a member! Head over to the ComicRack™ Wall to join in!



You will get a lot of variety on the ComicRack™ facebook page. ComicRack™ updates, script updates, polls, cover of the week, moment of the week, recent news in the comics world, new comic previews, ComicRack™ screenshots, and much more..
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News To find out when the new builds of ComicRack™ release and all the other news, while you can always use the forum or your facebook page, you also have the option to check all the latest news from within the comfort of ComicRack™. Here is what you need to do: • From the Help menu, choose the News option • The Latest ComicRack™ News dialog will open • All the latest RSS feeds are present in the left column under the title heading. • Clicking on a title opens up its news in the right column



Reading the Latest ComicRack™ News is the easiest & fastest way to keep in touch with all the latest updates to ComicRack™. You can also enable the Check for news on startup option to open the news dialog every time ComicRack™ starts. This way you’ll never catch an update late!



You can also use the Preferences dialog to enable checking for the latest news at startup: • Preferences → Behavior → Check for the latest news on ComicRack™
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Donations Why donate ? Hundreds of hours of work have been put into ComicRack™ to make it the best, most versatile and simply the most fun to use comic reader in the world. Starting out as a small fun project, it has evolved into what you currently see, a multi-language application with it’s own web site and support forums; simply put, a place for the ComicRack™ community. So if you think ComicRack™ adds value to your life, give something back. 10,000s of downloads and usually an average of €10 donations a month do not really fit together. It’s not about getting rich (as you can estimate from the above value), but it is about justifying the time and work put into this and also the feeling that there is some worth in it. So please help to keep this project running.



How to donate ? 1. Go to the Donate page. You can go there by ei- 1 ther by opening the Support ComicRack™ dialog from the Help menu (or when it opens during statup) or by going to the Donate page from the ComicRack™ forum, or by simply following this link. 2. All donations are processed securely via PayPal. You don’t need to be subscribed to PayPal to make a donation and you can pay with a credit card or debit card if you wish. 3. Once you have donated, again open up the Support ComicRack™ dialog, and enter your email address. 4. Click Validate, and wait for a moment. Click OK to exit. The Support dialog shall not bother you again.
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C’mon now.. You’ve read all. Time to hit the donate button!
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